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Introduction

While TASSEL has changed considerably since its initial public release in 2001, its primary function continues to
be providing tools to investigate the relationship between phenotypes and genotypes'. TASSEL has functionality
for association study, evaluating evolutionary relationships, analysis of linkage disequilibrium, principal
component analysis, cluster analysis, missing data imputation and data visualization. TASSEL development has
been led by a group focused on maize genetics and genomics, and for these reasons that software has design and
computational optimizations that account for the biology found in many plants and breeding situations. Compared
to human genetics, many crops are highly diverse both at the nucleotide level and structural variations (10-50X
greater than humans), inbreeding is common, large families are common, and whole genome prediction is being
applied daily to real world problems. These biological differences lead to some different optimizations that are of
use to many biological systems outside of crops.

One of the design elements driving TASSEL development has been the need to analyze ever larger sets of data?.
TASSELS has at its heart lots of design optimizations for big data, including:

e Bit level encoding of nucleotides so genetic distance and linkage disequilibrium estimates can be
made very quickly (20-50X speed increases).

e Extensive use the HDF5 file format, which has been developed as a robust element of many
climate modelers for matrix style data

e Tools for extracting and calling SNPs from extensive Genotyping-by-Sequencing data (tested for
60,000 samples by over 2.5 million SNPs and 96 million sequence alleles).

e Projection and imputation procedures that are optimized for the large families in crops. Some of
these optimizations permit memory and computational improvements of >100,000 fold.

e Mixed models based on DNA relationships have come to dominate GWP (Meuwissen et al 2001)
and GWAS (Yu et al 2006), yet these models can be slow to solve. TASSEL has been a test bed
and implements some of the most best optimizations, such as EMMA (Kang at al 2008), plus
approaches optimize variance components once P3D (Zhang et al 2010) and EMMAX (Kang et al
2010). Compression algorithms are also available (Zhang et al 2010). When used correctly, these
optimizations make powerful GWAS computationally possible.

e The code is being continually optimized for larger numbers of cores and clusters. For example, we
generally run imputation on 64-core machines. And while Java provides some excellent is
interoperability between systems, its code is about 2-fold slower than optimized C libraries, and
10-fold slower than GPU processing for some problems. TASSELS is building out connection
layers directly to native code, when these efficiencies are need.

TASSEL was designed for a wide range of users, including those not expert in statistical genetics or computer
science. A GWAS using the mixed linear model method to incorporate information about population structure®®
and cryptic relationships® can be performed by in a few steps by “clicking” on the proper choices using a graphic
interface. All the processes necessary for the analysis are performed automatically, including importing phenotypic
and genotype data, imputing missing data (phenotype or genotype), filtering markers on minor allele frequency,
generating principal components and a kinship matrix to represent population structure and cryptic relationships,
optimizing compression level and performing GWAS.

The command-line version of TASSEL, called the Pipeline, provides users the ability to program tasks using a
script instead of the graphic user interface (GUI). This feature allows researchers to define tasks using a few lines
of code and provides the ability to use TASSEL as part of an analysis pipeline or to perform simulation studies.
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We are also building a larger community of scientist developers that are adding functionality to this platform and
working together to improve the system. So throughout this user manual you will see how to do most things three

different ways - with the GUI, with the pipeline, and with the API (application programming interface).
TASSEL is written in Java, thereby enabling its use with virtually any operating system. It can be installed using

Java Web Start technology by simply clicking on a link at www.maizegenetics.net/tassel. A stand-alone version of

TASSEL can also be downloaded to use in pipeline mode or in any situation where the user wishes to start the

software from a command line.
A quick way to get started using TASSEL is to load the tutorial data and try performing analyses. However,

because some of the necessary steps may not be intuitive, we recommend that new users follow the tutorial at end
of this manual. The objective of this section is to provide information necessary to install and start TASSEL

software and to provide a brief overview of the interface.

Getting Started
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1.1 Executing TASSEL
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1.2 Open Source Code

Open source code for TASSEL is available at: https:/bitbucket.org/tasseladmin/tassel-5-source. The package uses
a number of other libraries that are included in the TASSEL distribution. These include a modified version of the
PAL library (http:/www.cebl.auckland.ac.nz/pal-project/), the COLT library (http://dsd.Ibl.gov/~hoschek/colt/),
jFreeChart (http:/www.jfree.org/jfreechart/), Guava (Google Core Libraries)
(https://code.google.com/p/guava-libraries), JUnit (http:/junit.org), Archaeopteryx

(https://sites.google.com/site/cmzmasek/home/software/archaeopteryx), and BioJava (http://www.biojava.org).

1.3 Software Development Tools

jProfiler (http:/www.ej-technologies.com/products/jprofiler/overview.html)
install4j (http://www.ej-technologies.com/products/install4j/overview.html)
NetBeans IDE (https:/netbeans.org)

Eclipse (http:/www.eclipse.org)

IntelliJ (http:/www.jetbrains.com/idea)

Structure101 (http://structure101.com)

TeamViewer (http:/www.teamviewer.com)

Bitbucket (https:/bitbucket.org)

sourceforge (http://sourceforge.net)

JIRA (https://www.atlassian.com/software/jira)

Tower (http:/www.git-tower.com)

1.4 Graphical Interface

TASSEL is organized into five main panels. 1) At the top menus control functions. 2) The Data Tree at the top
left organizes data sets and results. Data set(s) displayed in the Data Tree must first be selected before a desired
function or analysis can be performed. To select multiple data sets, press the CTRL (or Command for Mac) key
while selecting the data sets. 3) The Report Panel is located below the Data Tree. It displays information about a
selected data set from the Data Tree, such as the type of data and how it was created. 4) The Progress Monitoring
Panel below the Report Panel shows the progress of running tasks and has buttons that can cancel tasks. 5) The
Main Panel occupies the right side of the viewing area, and displays the content of the selected data set from the
Data Tree.

1.5 Pipeline (Command Line Interface)

http://www.maizegenetics.net/tassel/docs/TasselPipelineCLILpdf

1.6 GBS Pipeline

http://www.maizegenetics.net/tassel/docs/TasselPipelineGBS .pdf



2 File Menu

The data tree can be saved in a binary format.

241 SaveDataTree
This feature allows you to save the entire eontents of the Data Tree panel to a default loeatton: This 15 helpful
when the user does not wish to reereate a Data Tree panel that is already well populated with imnfermation the next

2

NOTE: The information outlined above for saving a Data Tree is applicable to files that are, in general,
version specific. When a new version of TASSEL is released, a data tree saved with a previous version
might not load to the version. For longer term storage, the best practice is to save individual data sets
rather than the entire data tree.

2.1.5 Set Preferences

Currently there is only one preference. That is whether to retain “rare” alleles. This is irrelevant for nucleotide
data (A, C, G, T, -, +, N) because at that number of states, there is no data lost. Potentially with other types of
data, it could exceed the 14 max (per site) number of allele states. If you “Retain Rare Alleles”, the lower
frequency allele values will be consolidated into a rare (Z) state. Otherwise, those lower frequency alleles are
changed to unknown (N).

® O O Preferences...

Alignment Preferences...

IET Retain Rare Alleles

OK Cancel




3 Data Menu

The Data Menu has options to import and export data sets, as well as, other data manipulate functions.

3.1 Load

Load provides options to import files for genotypes, phenotypes, populations structure, and kinship matrices, etc.
The tutorial data can be downloaded from the TASSEL website at this link:

http:/www.maizegenetics.net/tassel/docs/TASSEL TutorialData3.zip.

To use the data, the zip file must be uncompressed and saved on your local machine. These tutorial files will load
correctly with the “Make Best Guess” option. Multiple files can be imported simultaneously by highlighting them
first (holding Shift or Control key while clicking) and then clicking the Open button.

8 00 File Loader

Choose File Type to Load.

() Load Hapmap 800 Re=g

(") Load HDF5 [ [ TASSELTutorialData :

W Load VCF Mame 4| Date Modified

() Load Plink M dB_sequence.phy Monday, July 19, 2010 5:28 PM
() Load Proiection Ali | diploid_SSR.txt Sunday, May 5, 2013 2:32 AM
\_/) Load Projection Alignment B mdp_genotype.hmp.oa Tuesday, July 13, 2010 1:49 PM
() Load Phylip ™ mdp_genotype.plk.map Tuesday, July 13, 2010 3:26 PM
- . ™ mdp_genotype.plk.ped Tuesday, July 13, 2010 3:26 PM
() Load FASTA File B mdp_kinship.txt Tuesday, July 13, 2010 2:25 PM
() Load Trait (data, covariates, or factors) B mdp_population_structure. txt Tuesday, July 13, 2010 2:32 PM

B mdp_traits.ixt sunday, January 30, 2011 3:04 AM

'._;_.' Load Square Numerical Matrix (i.e. kinship)
'._;.' Load a Genetic Map
'._;.' Load a Table Report

(*) Make Best Guess

File Format: | All Files =

| oK | | Cancel | | cancel | [ open |

3.1.1 Hapmap

Hapmap is a text based file format for storing sequence data. All the information for a series of SNPs as well as
the germplasm lines are stored in one file. The first row contains the header labels, and each additional row
contains all the information associated with a single SNP. The first 11 columns describe attributes of the SNP,
while the following columns describe the SNP value for a single germplasm line. The first 12 columns of the first
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row should look like this, where “Line 1” is the beginning of germplasm line names.

| rs# | alleles l chrom | pos | strand l assembly# | center | protLSID | assayLSID | panelLSID l QCcode | Line 1 |

While all 11 header columns are required, not all 11 of the columns need to be filled in for TASSEL to correctly
interpret the data. The only required fields are “chrom”, Chromosome name, and “pos”, Position. In the example
below, genotype values are represented by 2 characters (i.e. AA). Note that you can record those as single
character values (see “Nucleotide Codes” in the Appendix).

For TASSEL to correctly read Hapmap data, the data must be in order of position within each chromosome, and
the file should be TAB delimited (example below is in Excel only for easy viewing). If some of the data is missing
the correct number of TABs must still be present, so that TASSEL can properly assign data to columns.

rsi alleles | chrom pos strand assembly®  center protlSID  assayLSID  panel OCcode 33-16 38-11 4226 4722 AlB8
PZBOOB59.1  AJC 1 157104 + AGPv1 Panzea NA NA maize282  NA cC cC cC cC Al
PZA01271.1 C/G 1 19475984 + AGPv1 Panzea NA NA maize282  NA cC GG cC GG cC
PZAD3613.2 G/T 1 2914066  + AGPv1 Panzea NA NA maize282  NA GG GG GG GG GG
PZAD3613.1 AT 1 2914171+ AGPv1 Panzea NA NA maize282  NA T T T T T
PZa03614.2 A/G 1 2915078 + AGPv1 Panzea NA NA maize282  NA GG GG GG GG GG
PZAD3614.1 AT 1 2915242 + AGPv1 Panzea NA NA maize2B2 NA T T T
PZA00258.3 C/G 1 2973508 + AGPv1 Panzea NA NA maize282  NA GG cC cC CG cC
PZAD2962.13 AT 1 3205252 + AGPv1 Panzea NA NA maize282  NA T T T T T
PZAD2962.14 C/G 1 3205262 + AGPv1 Panzea NA NA maize282  NA cC cC cC cC cC
PZAD0599.25 C/T 1 3206000 + AGPv1 Panzea NA NA maize282  NA cC T cC T T
PZA021259.1 c/T 1 3706018 + AGPv1 Panzea NA NA maize282  NA T cC cC cC cC
PZA00393.1 c/T 1 4175293+ AGPv1 Panzea NA NA maize282  NA T T T cC T
PZAO2BE9.B  C/T 1 4429897  + AGPv1 Panzea NA NA maize282  NA cC T cC NN cC
PZAD2869.4 C/G 1 4429927  + AGPv1 Panzea NA NA maize282  NA cC cC cC NN GG
PZAD2869.2 c/T 1 4430055 + AGPv1 Panzea NA NA maize282  NA NN T T cC T
PZAD2032.1 AT 1 4450461  + AGPv1 Panzea NA NA maize282  NA Al T Al Al Al
zagll.5 AT 1 4835434  + AGPV1 Panzea NA NA, maize2B2  NA Al NN Al Al Al
zagll.2 AJC 1 4835558 + AGPv1 Panzea NA NA maize282  NA cC cC cC cC cC
zagll.6 C/T 1 4835658 + AGPV1 Panzea NA NA, maize2B2  NA T T T T T
PZDO00R1.2  C/T 1 4836542 + AGPv1 Panzea NA NA maize282  NA cC cC cC cC cC
zagll.1 AfC 1 4912526+ AGPV1 Panzea NA NA, maize2B2  NA Al AL Al Al Al
PZBO0919.1  AJC 1 5353319 + AGPv1 Panzea NA NA maize282  NA cC cC cC cC Al
PZBO0919.2 G/T 1 5353655 + AGPv1 Panzea NA NA maize282  NA GG GG GG GG GG

3.1.2 HDFS5 (Hierarchical Data Format version 5)

http://www .hdfgroup.org/HDF5

3.1.3 VCF (Variant Call Format)

http:// www.1000genomes.org/wiki/analysis/variant-call-format/vcf-variant-call-format-version-42

3.1.4 Plink

Plink is a whole genome association analysis tool set, which comes with its own text based data format. The data
is stored in a set of two files, a .map file and a .ped file.

The .ped file contains all the SNP values and has six mandatory header columns for Family ID, Individual ID,
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Paternal ID, Maternal ID, Sex and Phenotype. TASSEL only requires that the Individual ID field be filled in.
Each row of the .ped file describes a single germplasm line. Notice in Plink, an unknown character is represented
with a'0'. However in TASSEL an unknown character is represented with a 'N', and '0' is used to represent
heterozygous indel. TASSEL will automatically convert between the '0' and the 'N'. Any exported Plink files will
represent the heterozygous indel with a '+' (insertion) and a '-' (deletion).

The .map file describes all the SNPs in the associated .ped file, where each row provides information on one SNP.
The .map file must contain exactly four columns: Chromosome, rs#, Genetic distance and Position. TASSEL does
not require the Genetic distance field to be filled in.

Both files should be TAB delimited.

For a more detailed description on the data format, please visit the Plink basic usage and data formats webpage:

(http://pngu.mgh.harvard.edu/~purcell/plink/data.shtml).

3.1.5 Projection Alignment

3.1.6 Phylip

Details on Phylip format are described at the following website:

http://evolution.genetics.washington.edu/phylip/doc/sequence.html

3.1.7 FASTA

3.1.8 Numerical Data

This type of format is used for trait and covariate data such as population structure. Similar to sequence alignment
genotype data, numerical data also consists of two parts: a header that defines data structure and a body containing
the main data. Tabs should be used as delimiters. However, any white space character such as blank will be
treated as a delimiter as well. As a result, embedded blanks in names will cause data to be imported incorrectly.
We suggest representing missing values using “NA”, or “NaN”. However, any text value (e.g. “?”) will be
interpreted as missing data. There are several formats for numerical data to fit the requirement for modeling. Trait
data (dependent variables) can be imported by starting the first line with “<Trait>" and following that with the trait
names. Additional classifiers may also be included in subsequent header rows by starting the row with “<Header
name=xxx>" followed by a name for each column of data. For instance, to define environments, start the second
header row with “<Header name=env>"".

Comment lines may be inserted at the beginning of the file. Comment line begins with the character “#”.

3.1.8.1 Trait format

This format does not require users to provide information on number of rows and columns. The file starts with the
key word <Trait> followed by names of columns. The column for line should not be labeled.

12



Example 1, simple list of trait values:

<Trait> EarHT dpoll EarDia
811 59.5 NA NA

33-16 64.75 64.5 NA

38-11 92.25 68.5 37.897

4226 65.5 59.5 32.21933
4722 81.13 71.5 32.421

A188 27.5 62 31.419

Example 2, traits data collected in multiple environments:

<Trait> EarHT PlantHT EarHT PlantHt
<Header name=env> Locl Locl Loc2 Loc2
811 59.5 NA NA NA

33-16 64.75 121.5 NA NA

38-11 92.25 153.8 37.897 83.4

4226 65.5 130.1 32.21933 82.1

4722 81.13 165.7 32.421 90.1

A188 27.5 110.2 31.419 79.6

3.1.8.2 Covariate Format

Covariate data uses the same format as trait data except that the first line must be “<Covariate>". This line tells
TASSEL that the variables in this file will be used as covariates not as dependent variables. This is the format to
use for population structure covariates.

<Covariate>

<Trait> 01 Q2 03
33-16 0.014 0.972 0.014
38-11 0.003 0.993 0.004
4226 0.071 0.917 0.012
4722 0.035 0.854 0.111
A188 0.013 0.982 0.005

3.1.8.3 Marker Values as Numerical Co-variates

In some cases, a user may wish to have marker values treated as numerical co-variates. If the first line of
the file is “<Numeric>", then the data will be imported as numeric data but used as marker data in GLM
and MLM.

<Numeric>

<Marker> ml m2 m3 m4 mb5
33-16 01 1 0 O

38-11 0 01 0.3 0O

4226 001 1 0.5 0

3.1.9 Square Numerical Matrix
13



Kinship can be calculated externally from pedigrees by using SAS Proc Inbreeding'® or from markers by using
one of several available software packages. The following format is provided to import the resulting kinship
estimates:

If n represents the number of taxa, the format for kinship files is as follows:

n
TaxalName rl1 ri2 rin
Taxa2Name 121 r22 r2n
TaxanName rnl rn2 rnn
Here 1ij (i, j=1,2, ..., n) is the element in the kinship matrix located at row i and column j.

Missing values are not allowed for kinship matrix.

Important note: The current format is different from the format used in TASSEL version 2.0 or lower.

3.1.10 Table Report

Data can be imported as tab delimited text files. The first row of the file will be interpreted as column labels and
the remaining rows as rows in the table.

3.1.11TOPM (Tags on Physical Map)

3.2 Export

Options are provided to export sequence data: Hapmap, Plink, Phylip (Sequential or Interleaved). Phenotypes and
covariate data is exported as numerical trait data. Table Reports are exported as a tab delimited table. For
numerical data, the function of Export is similar to the Table function in Results mode.
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800 Export...

Choose File Type to Export

* Write Hapmap
Write HDF5
Write VCF
Write Plink
Write Phylip (Sequential)
Write Phylip (Interleaved)
Write Tab Delimited

DK Cancel

3.3 Sort Genotype File

TASSELS has strict requirements for the sites in a genotype file. Each site must be unique (as defined by its
locus/chromosome, position, and name) and they must be in order in the file. Genotype files produced by other
programs (and also earlier versions of TASSEL) often do not meet this second requirement and throw an error
when TASSEL tries to load them. It can be difficult to recreate TASSEL’s internal sort order by hand, so this
plugin allows the user to sort an input genotype file according to TASSEL’s rules and output it to a new file ready
for further analysis. (This sort is not done automatically at load time because the computational cost for sorting
large files can be very large. We feel it’s better for users to know what they’re getting into instead of being
surprised by it.) There is currently only support for sorting Hapmap and VCF files.

To sort a genotype file from the GUI, just select Data -> Sort Genotype File and fill in the appropriate
parameters in the popup dialog.

To sort a file from the command line, use the following command:

run_pipeline.pl -SortGenotypeTablePlugin -inputFile [filename] -outputFile
[filename] -fileType [Hapmap or VCF]

The -fileType flag is optional and is only needed if the input file’s extension doesn’t match a known file
extension (“.hmp.txt”, “.vct”, etc.).

3.4 Transform

This suite of functions allows multiple data manipulation on genotype and phenotype (numerical) data. When a
genotype data set is selected, the data are transformed to numbers. When a numerical data set is selected,
mathematical transformation, data imputation and principal component analysis (PCA) can be performed. The
Transform columns tags will be displayed in a Data dialog box with three tabs: Trans, Impute and PCA.

3.4.1 Genotype Numericalization
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Two options are provided to transform genotype from character to numerical as shown in the following dialog

box.

i Mumerical Genotype |

@ Collapse Mon Major Alleles

) Separate Alleles

Create Dataset H Close I

3.4.1.1 Collapse Non Major Alleles

This function assigns 1 to the major allele and 0 to any other alleles. The converted genotypes are saved in a new
numerical data set.

3.4.1.2 Separate Alleles

This function assigns an indicator (1 for present and 0 for absent) for each allele. The converted genotypes are
saved in a new numerical data set.

3.4.2 Transform and/or Standardize Data

The Trans dialog box is the default selection, as shown below. In the Column list, select the column(s) you wish
to transform. Then select the type of transformation you wish to execute. Selecting the Standardize checkbox will
transform data by subtracting the column mean from the value of the trait and then dividing by the column’s

standard deviation. Clicking on the Create Data set button will result in the placement of a dataset containing
only the selected columns in the Data Tree.
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Calumn
EarHT.null

dpoll.null
EarDia.null

Percent Missing Data

Trans | Impute | PCA

() Raise to Power |2 -
() Take Log |Base 10 =

[ Standardize

Create Dataset H Close ]

3.4.3 Impute Phenotype

The k-nearest-neighbor algorithm® is used to impute missing phenotype data. If data is missing for a taxon for one
of the traits, the algorithm finds other taxa (neighbors) that are most like it for the non-missing traits. It uses the
average of the neighbors to impute the missing data. Click on the Impute tab to display the following:

B - N =)
Calumn Percent Missing Data Impute -

dpoll.null
EarDia.null

EarHT.null .66 @ Manhatten Distance

() Eudid Distance

@ Unweighted Average

() Weighted Average

Mumber of Neighbors (): 3

Min. Freg. of Row Data:|0.80

Create Dataset ][ Close ]

3.44 PCA

Principal component analysis (PCA) can only be performed on a numerical data set without missing values. Two
methods are available: correlation or covariance. This determines whether a correlation or covariance matrix will
be used as the basis for the analysis. The default, correlation, is a reasonable choice for genetic data. The number
of PCA axes in the output data set can be controlled by selecting either of the minimum eigen value associated
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with each axis, the minimum percent of the variance captured by an axis or the number of axes. The resulting axes
will be sorted by the amount of variance each captures.

Colurnn Percent Missing Data

Trans | Impute | PCA

Method

(%) Correlation

() Covariance

Oukpuk

(#) Eigenvalue = |0

() varProp % = [0,33333

() Camponents = 38

-

Create Dataset ” Close l

3.5 Synonymizer (Synonymize Taxa Names)

This button makes taxa names uniform to permit the joining of data sets.

The join functions that generate fused data sets work by matching taxa names. Consequently, if multiple names
exist for a given taxon (an added suffix, alternative spellings, different naming conventions, etc.) then the two data
sets will not join correctly. To help remedy this, the Synonymizer function allows the taxa names of one data set to
replace similar taxa names in the second data set. It relies on an algorithm that calculates the degree of similarity
between names, using the name from the first set which is most similar to that in the second data set.

When using the Synonymizer, keep in mind that order of selection matters. Always select the data set with the
names you wish to use (the “real” name) first, and then, while holding down the CTRL key, click on the second
data set with the taxa names you wish to change (the “synonym”). Then click on the Synonymizer button. A
synonym data set will be placed on the Data Tree panel under Synonyms. Each name in the data set selected
second is now listed in the TaxaSynonym column. Next to this column is a TaxaRealName column listing the
highest scoring match derived from the “real” name data set. The MatchScore column gives an indication of the
amount of similarity between the two names (where 0 is no similarity and 1.0 is identity).
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|| Program Status

Caution! Before the synonyms are applied, we strongly encourage the user to check the match score, especially
for those taxa with low match scores. To do that, the user selects the synonym file and clicks the “Synonymizer”
button. The incorrect matches, usually the ones with the lowest match scores, can be rejected at this point. Sorting
on the match score column first makes this a fairly easy process.

In the event that some of the taxa are not interpreted correctly, matches can be modified manually. Select the taxa
you wish to modify on the left side, and then choose a replacement taxa from the right side. Click the arrow button

E] to substitute the taxa. Taxa with no synonym can be identified by selecting then clicking “No Synonym”.
Click OK to save the changes.
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Once it has been determined that the taxa names were matched correctly, the synonyms can be applied. With the
synonyms selected, hold down the CTRL key while clicking on the second/synonym data set (the data set whose
names you would like to change). Then once again click on the Synonymizer button to apply the new names to
the data set.

3.6 IntersectJoin

Command

./run pipeline.pl -forkl -h groupl.hmp.txt -fork2 -h group2.hmp.txt
—-combine3 —-inputl -input2 -intersect -export

groupl group2 intersect.hmp.txt -runforkl -runfork2 -runfork3

This joins multiple data sets by the intersection of their taxa. Taxa must be present in both data sets to be included.
Select multiple data sets using the CTRL key in conjunction with mouse clicks, and then click on the intersection
button to join the data sets. Because this function uses taxa names to join data sets, any variation in taxa names can
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prevent proper joining. Taxa names can be made uniform by using the “Synonymizer”.

3.7 Union Join

Command

./run pipeline.pl -forkl -h groupl.hmp.txt -fork2 -h group2.hmp.txt
—-combine3 -inputl -input2 -intersect -export groupl groupZ2 union.hmp.txt
-runforkl -runfork?2 -runfork3

This joins multiple data sets by a union of their taxa. Missing data will be inserted if taxa are missing from one
data set. Select multiple data sets using the CTRL key in conjunction with mouse clicks, and then click on the
union button to join the data sets. Because this function uses taxa names to join data sets, any variation in taxa
names can prevent proper joining. Taxa names can be made uniform by using the “Synonymizer”.

3.8 Merge Genotype Tables

Command

./run pipeline.pl -forkl -h groupl.hmp.txt -fork2 -h group2.hmp.txt
-combine3 -inputl -input2 -mergeAlignments -export

groupl groupZ2 merge.hmp.txt -runforkl -runfork2 -runfork3

This is the most complex merge function, and can be considered as a union join across both sites and taxa. (The
actual -union join only works across taxa.) The resulting genotype table will contain all unique sites and all unique
taxa from across the input datasets. If a specific site-taxon combination isn’t present in any input dataset, the value
is set to missing. If a specific site-taxon combination is present in more than one input file, the output will contain
the last value processed. (That is, later values overwrite earlier values even if they conflict. There are plans to
change this, but they have not been implemented yet.)

Notes
e This maps to “Data -> Merge Genotype Tables” Menu on GUI.
e Errorif duplicate site names in same file. (same as with other file loadings)
e Undefined taxa / site allele values are set to UNKNOWN.
e Duplicate taxa / site set to last Alignment processed.
e Sites are identified by Locus (chromosome), Physical Position, and Site Name

3.9 Separate

This separates the selected data set into it’s components. For example, a genotype table would be separated into
individual chromosomes.
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3.10 Homozygous Genotype

This changes all heterozygous values to unknown (N).

4 Impute Menu

4.1 Genotypic Imputation

TASSELS contains two methods for imputing missing genotype information, one is a generalized approach
suitable for all types of populations but optimized for those with higher inbreeding coefficients (FILLIN) and the
other is specifically optimized for finding recombination break points in full-sib families (FSFHap). More
information on these two methods can be found at:

Swarts et al. FSFHap (Full-Sib Family Haplotype Imputation) and FILLIN (Fast, Inbred Line Library
ImputatioN) optimize genotypic imputation for low-coverage, next-generation sequence data in crop plants, Plant
Genome, in review.

FSFHap (Full-Sib Family Haplotype Imputation):

FSFHap imputes missing genotypes and corrects genotyping errors for inbred individuals in full-sib families. It is
very useful for calling haplotypes in low-coverage GBS data. The individuals must be at least partially inbred
because the method relies on finding inbred segments to identify haplotypes. It does not use the parent genotypes
directly, but including the parents may be useful for interpreting the results. The algorithms used for imputation
analyze one chromosome and family at a time. As a result, a pedigree file must be supplied that indicates which
entries belong to which family. Also, input genotypes must contain data for only a single chromosome. If the
genotype file contains multiple chromosomes, the chromosomes can be separated using the TASSEL -separate
command.

Pedigree File Format:

The only file format specific to FSFHap is the pedigree file. The taxa names must exactly match names in the
genotype data. If the genotype data contains taxa not included in the pedigree file, only individuals listed in the
pedigree file will be analyzed. The input genotypes can be in any of the formats accepted by TASSEL. The
pedigree file must contain the names of the individual taxa to be analyzed, the family to which each belongs, the
parents, the parent contributions, and the average inbreeding coefficient. The first row in the file must be column
headers. The values in the columns should be tab-delimited and are expected to be in the following order: family,
taxon, parentl, parent2, parentl Contribution, parent2Contribution, F. The F value is not required but all other
columns are.

Example:

family taxonName  parentl parent2 contributionl contribution2 F
faml t0001 parl  par2 0.5 0.5 92
faml t0002 parl par2 0.5 0.5 .92
fam2 10201 parl  par3 0.5 0.5 .92
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fam2 10202 parl  par3 0.5 0.5 .92
fam2 10203 parl  par3 0.5 0.5 .92

The values for contribution1, contribution2, and F are family means. Those values are read from the first line for a
family only and then applied to the entire family.

Using the command line for FSFHap:

FSFHap consists of three TASSEL plugins, CallParentAllelesPlugin, ViterbiAlgorithmPlugin, and
WritePopulationAlignmentPlugin, which are called sequentially. A typical command for running FSFHap is as
follows (replace items in <> with actual parameter values) for a genotype containing a single chromosome:

run_pipeline.pl -h <genotypeFilename> -CallParentAllelesPlugin -p <pedigreeFilename>
-m 0.9 -r 0.5 -logfile <logFilename> -endPlugin -ViterbiAlgorithmPlugin -g true
-endPlugin -WritePopulationAlignmentPlugin -f <outputFilename> -m false -o parents
-endPlugin

For a genotype file containing multiple chromosomes:

run_pipeline.pl -h <genotypeFilename> -separate -CallParentAllelesPlugin -p
<pedigreeFilename> -m 0.9 -r 0.5 -logfile <logFilename> -endPlugin
-ViterbiAlgorithmPlugin -g true -endPlugin -WritePopulationAlignmentPlugin -f
<outputFilename> -m false -o parents -endPlugin

Options for CallParentAllelesPlugin:
Options taking a parameter value specified by Value = []:
-p or -pedigrees the pedigree file. Value = [filename]
-w or -windowSize  the number of SNPs to examine for each LD cluster.
Value = [integer] (default = 50)
-r or -minR minimum R used to filter SNPs on LD
Value = [number between 0 and 1]. (default = 0.2, use 0 for no 1d filter)
-m or -maxMissing ~ maximum proportion of missing data allowed for a SNP
Value = [number between 0 and 1]. (default = 0.9)
-f or -minMaf minimum minor allele frequency used to filter SNPs. If negative, filters on
expected segregation ratio from parental contribution.
Value = [number between 1 and -1]. (default=-1)

-b or -bcl use BC1 specific filter. Value = [true or false] (default = true)
-n or -bcn use multiple backcross specific filter. Value = [true or false] (default = false)
-logfile the name of a file to which all logged messages will be printed. Value = [filename].

Options not taking a parameter value:

-cluster use the cluster algorithm. minMaf defaults to 0.05.
-subpops filter sites for heterozygosity in subpopulations.

-nohets delete het calls from original data before imputing.
-windowld use the window 1d algorithm for finding parent haplotypes

99 ¢

The “-cluster”, “-subpops”, “-nohets”, and “-windowld” options do not take parameters but only act as flags that
include certain features in the analysis. Of those, cluster and windowld are the most useful. When the -cluster
option is used, a different algorithm is used that does a better job of handling residual heterozygosity in the
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parents. However, it does not perform well for partially inbred RILs that have only been self-pollinated for one or
two generations. If the RILs being imputed are F2’s or F3’s, the “~cluster” option should not be used. The
“-subpops” option should only be used when imputing families of the NAM population developed by the Maize
Diversity Project. The “-nohets” option was included to test whether or not erroneous het calls result in too many
hets being imputed. It appears to have only a small effect on the outcome. The -windowld algorithm handles F2
and later populations effectively, but can have problems when parents have some residual heterozygosity.

It is recommended that the -logfile option be used. The output can be used to identify and diagnose possible
problems. The “-ben true” should be used for populations with two or more backcrosses. However, using the

“-bc1” option is not necessary as the default behavior is usually best.

Options for ViterbiAlgorithm Plugin:

-g or -fillgaps if true then missing values flanked by SNPs from the same parent will be imputed
to that parent, false otherwise. Value = [true or false] (default = true)
-h or -phet expected frequency of heterozygous loci. Used only if the inbreeding coefficient is

not specified in the pedigree file. Value = [number between 0 and 1] (default = 0.07)

Options for WritePopulationAlignmentsPlugin.:

Required:

-for -file The base file name for the ouput. .hmp.txt will be appended. Value = [filename]

Optional:

-m or -merge if true then families are merged into a single file, if false then each family is output
to a separate file. Value = [true or false] (default = false)

-0 or -outputType if value = parents then output parent calls, if value = nucleotides then output nucleotides,
if value = both then output both in separate files (default = both)

-d or -diploid if true output is AA/CC/AC, if false output is A/C/M.

Value = [true or false] (default = false)

-c or -minCoverage the minimum coverage for a monomorphic snp to be included in the nucleotide output.
Value = [number between 0 and 1] (default = 0.1)

-X or -maxMono the maximum minor allele frequency used to call monomorphic snps (default = 0.01)

For individual families, only polymorphic SNPs are imputed. When merge = false, only those SNPs appear in the
output. When merge = true, SNPs that are polymorphic in any family will be written to output. For any site, if
SNP coverage is high enough in a family to determine with confidence that it is monomorphic for that family, then
all individuals in that family will be imputed to the monomorphic value at that site. The -minCoverage and
-maxMono options are used to determine thresholds for determining whether a site will be called monomorphic in
a family. If either of the options is set to a value of NaN, then missing values at monomorphic sites will not be
imputed.

FILLIN (Fast, Inbred Line Library ImputatioN): The generalized approach

FILLIN imputes missing genotypes in two steps, 1) haplotype generation (FILLINFindHaplotypesPlugin) and 2)
imputation of the resulting haplotypes back onto the target samples (FILLINImputationPlugin).

Haplotypes are generated by collapsing low coverage but inbred segments that share identity by state to an
optionally user-supplied threshold value by site window (default: 8k); this is performed by the first plugin,
FILLINFindHaplotypesPlugin. Because short IBD segments may be replicated widely within a species, even
between diverse individuals, we recommend supplying all the information available within a species for this step.
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The second plugin, FILLINImputationPlugin, uses these haplotypes to impute missing genotypes in target
individuals. It does so in multiple steps, first looking for haplotypes that match the minor alleles to a threshold
within the whole site window (1a in schematic below) and, if this fails, looks for two haplotypes to explain the site
window and, assuming this represents a recombination break point between two inbred haplotypes, uses a Viterbi
HMM algorithm to model the recombination breakpoints (2a). If two haplotypes cannot be found to explain the
whole site window, the algorithm next searches for haplotypes to explain a smaller focus window within the site
window centered on 64 sites at a time and searching to the right and left until enough informative minor alleles are
found. It does this by first looking for one haplotype to a threshold (2a), then two modeling a recombination break
between inbred segments (2b), then finally, to a higher threshold, looks for two haplotypes and models the 64
focus site window as heterozygous, combining the two haplotypes together. The thresholds for 2a-c are also set
differently based on whether the whole sequence of the target taxon is above or below a user supplied
heterozygosity threshold. For taxon considered outbred (above the threshold), 2b the Viterbi option is never used
because it is more likely in an outbred taxon that if two haplotypes explain a segment it is heterozygous for those
two haplotypes. If the algorithm cannot find haplotypes to satisfy any of these threshold requirements, the segment
will not be imputed. The thresholds for the focus block imputation are set based on the mxInbErr and mxHybErr
values entered (or defaults):

Below mxHet (inbred) | Above mxHet (outbred)

2a | 3/10*mxInbErr 1/10*mxInbErr
2b | s*mxHybErr 0
2¢ | mxInbErr mxInbErr
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Running FILLIN:

FILLIN consists of two TASSEL plugins, FILLINFindHaplotypesPlugin and FILLINImputationPlugin, which
are called sequentially. If you would like to mask your data and calculate accuracy, use the -accuracy flag for
FILLINImputationPlugin. If imputing maize, a donor file of haplotypes from 40k+ taxa can be found on the
Panzea website (http://www.panzea.org/lit/data_sets.html). FILLIN can be run either within the TASSEL GUI or
through the command line. The options are the same for both.

A typical command sequence for running FILLIN through the command line is as follows (replace items in <>
with actual parameter values):

run_pipeline.pl -FILLINFindHaplotypesPlugin -hmp <genotypeFilename> -o
<outDonorDir>

run_pipeline.pl -FILLINImputationPlugin -hmp <genotypeFilename> -d <donorDir> -0
<outFile.hmp.txt.gz>

To run FILLIN from the GUI go to Impute->FILLINFindHaplotypesPlugin or FILLINImputationPlugin

Options for FILLINFindHaplotypesPlugin:

-hmp <Target file> :
Input genotypes to generate haplotypes from. Usually best to use all available samples from a species.
Accepts all file types supported by TASSELS. (required)

-0 <Donor dir/file basename> :
Output file directory name, or new directory path; Directory will be created, if doesn't exist. Outfiles will
be placed in the directory and given the same name and appended with the substring '.gc#s#.hmp.txt' to
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denote chromosome and section (required)
-mxDiv <Max divergence from founder> :
Maximum genetic divergence from founder haplotype to cluster sequences (Default: 0.01)
-mxHet <Max heterozygosity of output haplotypes> :
Maximum heterozygosity of output haplotype. Heterozygosity results from clustering sequences that either
have residual heterozygosity or clustering sequences that do not share all minor alleles. (Default: 0.01)
-minSites <Min sites to cluster> :
The minimum number of sites present in two taxa to compare genetic distance to evaluate similarity for
clustering (Default: 50)
-mxErr <Max combined error to impute two donors> :
The maximum genetic divergence allowable to cluster taxa (Default: 0.05)
-hapSize <Preferred haplotype size> :
Preferred haplotype block size in sites (minimum 64); will use the closest multiple of 64 at or below the
supplied value (Default: 8192)
-minPres <Min sites to test match> :
Minimum number of present sites within input sequence to do the search (Default: 500)
-maxHap <Max haplotypes per segment> :
Maximum number of haplotypes per segment (Default: 3000)
-minTaxa <Min taxa to generate a haplotype> :
Minimum number of taxa to generate a haplotype (Default: 2)
-maxOutMiss <Max frequency missing per haplotype> :
Maximum frequency of missing data in the output haplotype (Default: 0.4)
-nV <true | false> :
Supress system out (Default: false)
-extOut <true | false> :
Details of taxa included in each haplotype to system out (Default: false)

Options for FILLINImputationPlugin:
-hmp <Target file> :
Input HapMap file of target genotypes to impute. Accepts all file types supported by TASSELS (required)
-d <Donor Dir> :
Directory containing donor haplotype files from output of FILLINFindHaplotypesPlugin. All files with
".gc' in the filename will be read in, only those with matching sites are used (required)
-0 <Output filename> :
Output file; hmp.txt.gz and .hmp.hS5 accepted. (required)
-hapSize <Preferred haplotype size> :
Preferred haplotype block size in sites (use same as in FILLINFindHaplotypesPlugin) (Default: 8000)
-hetThresh <Heterozygosity threshold> :
Threshold per taxon heterozygosity for treating taxon as heterozygous (no Viterbi, het thresholds).
(Default: 0.01)
-mxInbErr <Max error to impute one donor> :
Maximum error rate for applying one haplotype to entire site window (Default: 0.01)
-mxHybErr <Max combined error to impute two donors> :
Maximum error rate for applying Viterbi with to haplotypes to entire site window (Default: 0.003)
-mnTestSite <Min sites to test match> :
Minimum number of sites to test for IBS between haplotype and target in focus block (Default: 20)
-minMnCnt <Min num of minor alleles to compare> :
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Minimum number of informative minor alleles in the search window (or 10X major) (Default: 20)
-mxDonH <Max donor hypotheses> :

Maximum number of donor hypotheses to be explored (Default: 20)
-hybNN <true | false> :

If true, uses combination mode in focus block, else does not impute (Default: true)
-ProjA <true | false> :

Create a projection alignment for high density markers (Default: false)
-impDonor <true | false> :

Impute the donor file itself (Default: false)
-nV <true | false> :

Supress system out (Default: false)
Options for calculating accuracy
-accuracy <true | false> :

Masks input file before imputation and calculates accuracy based on masked genotypes (Default: false)
-propSitesMask <Proportion of genotypes to mask if no depth> :

Proportion of genotypes to mask for accuracy calculation if depth not available (Default: 0.01)
-depthMask <Depth of genotypes to mask> :

Depth of genotypes to mask for accuracy calculation if depth information available (Default: 9)
-propDepthSitesMask <Proportion of depth genotypes to mask> :

Proportion of genotypes of given depth to mask for accuracy calculation if depth available (Default: 0.2)

5 Filter Menu
5.1 Sites

The genotype table can be filtered in several ways. For example, monomorphic sites can be eliminated, and
regions of a sequence can be eliminated.
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@00 Filter Alignment

Filter Alignment
Minimum Count: 10 out of 281 sequences
Minimum Frequency: 0.1
Maximum Frequency: 1.0
Position Type: Position index
Start Position: 0
End Position: 3092

of 3092 sites

Remove minor SNP states
Generate haplotypes via sliding window
Haplotype Length

step Lengtn

Filter Select Chromosomes... Cancel

Minimum Count - the minimum number of taxa in which the site must have been scored to be included in the
filtered data set (GAP or missing data do not count).

Minimum Frequency - the minimum frequency of the minority polymorphisms for the site to be included in the
filtered data set.

Start Position, End Position — establishes the range of sites for filtering.

Extract Indels - if selected, indels are extracted from the alignment. If not selected, only point substitutions are
extracted.

Remove minor SNP states — converts tertiary and rarer states to missing data (“?”’), thereby forcing sites to have
only two types of segregating sites at a locus. This may help remove sequencing errors.

Generate haplotypes via sliding window — creates haplotypes from an ordered set of SNPs.

Example Pipeline Command that removes SNPs with MAF (Minimum Allele Frequency) less than 5%

run pipeline.pl -forkl -h mdp genotype.hmp.txt -filterAlign
-filterAlignMinFreq 0.05 -export filtered genotype -runforkl
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5.2 Site Names

First select the genotypic data from the data tree. The resulting dialog displays the site names associated with the
selected data. By using either the CTRL or SHIFT key in conjunction with the mouse, the user can select or
deselect site names. Once desired site names have been moved to the “Selected” window using the “Add ->”
button, the “Capture Selected” or “Capture Unselected” buttons will create a new data set containing only the
desired site names.

Using the search box...

* *isthe wildcard.
* *isalways implied at end of search string.

» Search string is case sensitive. For example: use [Aa]bc to match site names beginning with Abc or abc.
* PZ[AB] Will match anything starting with PZA or PZB.

(= NONS Site Mame Filter

Available Selected
PZEOOBSS.1 &I PZAD3IG13.2
PZADL1271.1 PZAD3IB13.1
PZAD3013.2 PZADZ2902.13
PZAD3IB13.1

PZAD3614.2 " Add 3

PZA03614.1

PZAODDZ58.3

PZA02962.13 E

PZAD2962.14 |
PZ[AB]

{ Capture Selected :} ':: Capture Unselected ;‘ [ Remove | [ Cancel

N = o =

5.3 Taxa Names

First select the genotypic, phenotypic, or population structure data from the data tree. The resulting dialog displays
the taxa associated with the selected data. By using either the CTRL or SHIFT key in conjunction with the mouse,
the user can select or deselect taxa. Once desired taxa have been moved to the “Selected” window using the “Add
->” button, the “Capture Selected” or “Capture Unselected” buttons will create a new data set containing only the
desired taxa.

Using the search box...

* *is the wildcard.
* *isalways implied at end of search string.
» Search string is case sensitive. For example: use [Aa]bc to match taxa beginning with Abc or abc.
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* A[56] Will match anything starting with AS or A6

Mare Taxa Filter
Available Selected
ASS54 AS56
Ab
ABL9
AB32

AB35
Ab4l
ABS4

A[56]

( Capture Selected ) C Capture Unselected )

Cancel

5.4 Taxa

5.5 Traits

Clicking the “Traits” button on the “Data” toolbar launches the Trait Filter dialog. This dialog is used with
numerical data sets to (1) change the trait type, (2) view, but not change whether the trait is discrete or continuous
and (3) drop one or more traits from the data set. In addition, the dialog can be used to view the trait properties
without changing them. If the “OK” button is clicked, a new data set is created that incorporates the changes, the
original data set remains unchanged, and the dialog closes. If the “Cancel” button is clicked no data set is created,

8006

Filter Taxa by Properties

Min Proportion of Sites Present |ﬂ'.!:'i'!:'i'

Min Heterozygous Proportion 0.0

Max Heterozygous Proportion 1.0

| Ok | | Close |

the original data set remains unchanged, and the dialog closes.

Allowable trait types are data, covariate, factor and marker. Generally, data and covariate traits will be continuous
(not discrete) and factor will be discrete. Markers in a numerical data set will be continuous. Discrete valued
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markers are better imported as genotypes and filtered using the “Sites” filter.

Clicking “Exclude All” unchecks the “Include” box for all traits. Clicking “Include AIl” checks the “Include” box
for all traits. The “Exclude Selected” and “Include Selected” buttons do the same thing for traits that have been
highlighted by selecting them with the mouse. Type can be changed for individual traits by selecting a value in the
drop down box in the type column for that trait. Type can be changed for multiple traits by selecting those traits
then clicking one of the “Change Selected Type to ...” buttons.

Important: Once a numerical data set has been joined with genotypes, it can no longer be modified using the trait
filter function.

800 Filter Traits / Modify Trait Properties

Trait Type Discrete Include
Q1 covariate ™
covariate ™

Q2
s Joovariae | @ | @ |

| Exclude Selected | | Include Selected |

| Exclude All | | Include All |

| Change Selected Type to Data |

| Change Selected Type to Covariate |

| Change Selected Type to Marker |

| oK | | Cancel |

6 Analysis Menu

6.1 Diversity
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This executes a basic diversity analysis.

Average pairwise divergence (), segregating sites, and 0 estimates (4Np) can be calculated, as well as sliding
windows of diversity.

To run a diversity analysis, click on a raw sequence alignment, and then select Analysis -> Diversity.

. 3 ™~
| £ Diversity Surveys
Intran Start Base |0
Synonymous End Base |2465
on-transcribed
loncoding Indels
Transcribed [7] Sliding Window
MNonsynonymous Step 100

Window 500

[[] Indels

l Run H Close I

In the resulting Diversity Surveys dialog box, the various site classes available for analysis are listed on the left. If
the sequence has no annotation, then only the “Overall” and “Indels” options will be active.

A sliding window of diversity can also be calculated across the region. To produce a sliding window, check the
box next to “Sliding Window,” and then enter the desired step size and size of the sliding window.

Results can be plotted using Results -> Chart or viewed in a table via Results => Table.

6.2 Linkage Disequilibrium

This generates a linkage disequilibrium data set from SNP data.
NOTE: It is important to use only filtered data sets (apply Filter -> Sites first) when estimating linkage

disequilibrium, as a raw alignment with numerous invariant bases will take a very long time and consume a large
amount of memory to calculate.
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® () O  Linkage Disequilibrium

Select LD type: | Sliding Window

LD Window Size: 50

Sliding Window LD with 153375 comparisons.

How to treat heterozygous calls:
Set to missing ;

Accumulate R2 Results

Run Close

Linkage disequilibrium between any set of polymorphisms can be estimated by clicking on a filtered set of
polymorphisms and then using Analysis [ Link. Diseq. At this time, D', 72 and P-values will be estimated. The
current version calculates LD between haplotypes with known phase only (unphased diploid genotypes are not
supported; see PowerMarker or Arlequin for genotype support).

D' is the standardized disequilibrium coefficient, a useful statistic for determining whether recombination
or homoplasy has occurred between a pair of alleles.

# represents the correlation between alleles at two loci, which is informative for evaluating the resolution
of association approaches.

D' and 2 can be calculated®’ when only two alleles are present. If multiple alleles are present, a weighted average
of D'or 2 is calculated between the two loci?2. This weighted average is determined by calculating D' or 2 for all
possible combinations of alleles, and then weighting them according to the allele's frequency. Note: It is not
entirely certain that this procedure fully accounts for allele number effects.

P-values are determined by two methods. If only two alleles are present at both loci, then a two-sided Fisher's
Exact test is calculated. Note: Previous editions of TASSEL used a one-sided test, but TASSEL version 1.0.8 and
later use a two-sided test.

If more than two alleles are present, permutations are used to calculate the proportion of permuted gamete
distributions that are less probable then the observed gamete distribution under the null hypothesis of
independence?’ .

When calculating linkage disequilibrium, users have the option of employing “Rapid Permutations.” If this
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option is selected, the algorithm will compute either a fixed number of permutations or run until 10 permutations
are found that are more significant than the observed P-value. While this slightly reduces P-values, it also saves a
large amount of computational time. If an unbiased p-value is desired, then the user must unselect the “Rapid
Permutations” check box.

“Full Matrix LD calculates LD for every combination of sites in the alignment. “Sliding Window LD calculates
LD for sites within a window of sites surrounding the current site. The LD Window Size determines the width of
the window on one side of the current site.

Linkage disequilibrium results can be plotted using Results -> LD Plot or viewed in a table via

(Results -> Table).

6.3 Cladogram

800 Create Tree

v/ Save distance matrix

Clustering Method
Meighbor Joining =

Run Close

This function generates a tree or cladogram data set.
TASSEL produces neighbor-joining trees using only simple parsimony substitution models.

To retrieve cladogram data, first select genotypic data from the Data Tree and then click Analysis -> Cladogram.
The resulting tree data and the corresponding matrix will appear as separate data sets on the Data Tree.

Results can be plotted using Results -> Archaeopteryx Tree.

6.4 Kinship

This function generates a kinship matrix from a genotype. To do so, first highlight SNP data then click on the
“Analysis/Kinship” submenu. The resulting dialog box will then provide the option to select “scaled IBS” or
“pairwise IBS”. Clicking “OK” generates a kinship matrix.

When a genotype file is selected and “pairwise IBS”, each element i,j of the kinship matrix that is generated is
equal to the proportion of the SNPs which are different between taxon i and taxon j. Distance is calculated for
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each pair of taxa, ignoring any sites that have a missing value for one of the taxa. The distance matrix is converted
to a similarity matrix by subtracting all values from 2 then scaling so that the minimum value in the matrix is 0 and
the maximum value is 2. Kinship can be derived from a set of random SNP data (a minimum of several hundred
SNPs spread over the whole genome is recommended). This ad-hoc rescaling method was implemented in an
earlier version of TASSEL in order to provide a reasonable estimate of additive genetic variance, but tends to
overestimate that value. Rescaling does not affect its use for correcting for population structure. It only affects the
estimate of additive genetic variance and, consequently, heritability.

To provide a better estimate of addivitive genetic variance, an alternative method can be used by selecting “scaled
IBS”. This method (from Endelman and Jannink, 2012) codes genotypes as 2, 1, or 0, equal to the count of one of
the alleles at that locus. It then replaces missing genotype values with the average genotypic score at that locus
before estimating a relationship matrix. Other methods of imputing genotypes prior to calculating Kinship may
provide a better result. For instance, rather than using this default treatment of missing values, using the numerical
genotype method followed by imputation described in section 3.3 before running Kinship is a reasonable
alternative. When using numerical genotypes, Kinship always applies the “scaled IBS” method.

Users may also load their own kinship data using Data [1 Load. Kinship matrices can be calculated using the
SPAGeDi software package (http:/www.ulb.ac.be/sciences/ecoevol/spagedi.html). Comparisons of methods for
calculating kinship can be found in the literature (e.g. Stich et al. 2008).

6.5 GLM (General Linear Model)

This function performs association analysis using a least squares fixed effects linear model.

TASSEL utilizes a fixed effects linear model to test for association between segregating sites and phenotypes. The
analysis optionally accounts for population structure using covariates that indicate degree of membership in
underlying populations. A main effects only model is automatically built using all variables in the input data. A
separate model is built and solved for each trait and marker combination. Any factors, covariates, reps or locations
are included in every model as main effects. How the data is used must be defined either in the input data files or
using the Trait Filter after the data has been imported but before it has been joined with a genotype.

General Linear Model (GLM) can be run using a numeric data set only or using numeric data joined to genotype
data. If only numeric data is selected, best linear unbiased estimates (BLUEs or least square means) will be
generated for the taxa for each trait. [Note: only factors and covariates intended to control field variation should be
included at this stage. Population structure covariates which are intended to control for marker effects should only
be included when markers are also in the analysis.] If numeric data with genotypes are analyzed, each trait by
marker combination will be tested and two reports will be produced, one containing trait by marker F-tests and the
other containing allele estimates.

To run GLM, select a data set and then click the GLM button. A dialog box will pop-up to allow the user to
indicate that a permutation test should be run and to allow the number of permutations to be changed. The
permutation test will be run using the method suggested by Anderson and Ter Braak (2003), which calculates the
predicted and residual values of the reduced model (contained all terms except markers) then permutes the
residuals and adds them to the predicted values. When the GLM options dialog is closed, the user is presented
with a dialog allowing the output to be saved to a file rather than stored in memory and displayed by TASSEL.
This option is useful when the output is expected to be very large and risks exceeding available RAM.
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The following table shows an example of the Marker Test output as viewed with Results/Table:

T Marker Test

|

Trait
EarDia

Marker
FZB00859. 1

Locus

Locus_pos
157104

marker_F

1.663

marker_p

0.199

markerR2

0.007
0

markerDF

markerM5
23.522

errorDF

223

errorMs

14144

modelDF

modelMs

31.921

»

EarDia

PZAD1271.1

1947934

0.005

0.942

0.078

222)

14.081

22.88

EarDia

PZAD3613.2

2914066

0,144

0.705

0.001

2126

227)

14.791

27.224

EarDia

PZAD3613.1

2914171

0.014

0.905

0

0.208

14.656

24.487|

EarDia

PZAD3614.2

2915078

0.018

0.894

0

0.261

215

14.742

35.401

EarDia

PZAD3614.1

2915242

2663

0.104

0.012

39.907

213

14.984

38.967|

EarDia

PZADO258.3

1
1
1
1
1
1
1
1

2973508

0.42]

0.517

0.002

1
1
1
1
1
1
1
1

6.089

14,487

| | L L | e Ll

25.438

EarDia

PZAD2962.13

3205252

0.374

0.541

0.002

5.374]

217]

14,357

25.183| =

4 r

[ Pt | [ Export(csv) || Export(rab) |

In addition to displaying the F-statistics and p-values for the requested F-tests, the table also contains markerR2,
mean squares (MS) and degrees of freedom (DF) for the marker effect, for the model (corrected for the mean), and
for error. If taxa are replicated (across reps or environments), then the markers are tested using the taxa within
marker mean square. If taxa are unreplicated, then the residual mean square is used. MarkerR2 is the marginal
R-squared for the marker calculated as SS Marker (after fitting all other model terms) / SS Total, where SS stands
for sum of squares. The following table shows an example of the Allele Estimates output as viewed with
Results/Table:

F |
T Allele Estimates Iﬁ
Trait Marker Cbs Locus Locus_pos Allele Estimate
EarDia PZBEODE59.1 1811 157104(C 0.804]
EarDia PZBEODE59.1 451 157104{4 o=
EarDia PZAD1271.1 117(1 1947984|G 0.039
EarDia PZAD1271.1 1091 19479584|C 0
FarMhiz D7ANTILAT D fal1 pla R IF. Ty Pt ) n 13 7
4 3

| print || Export(csv) || Export(rab) |
L

For each marker and trait combination, each marker allele is listed along with the number of observations for taxa
carrying that allele (Obs), the locus (usually chromosome) and locus position of that marker, the allele, and the
estimate of the effect of that allele. Because of the way that GLM codes alleles, the last allele estimate for a marker
is always zero and the other allele estimates are relative to that.

6.6 MLM (Mixed Linear Model)

This conducts association analysis via a mixed linear model (MLM).

A mixed model is one which includes both fixed and random effects. Including random effects gives MLM the
ability to incorporate information about relationships among individuals. When a genetic marker based kinship
matrix (K) is used jointly with population structure (Q), the “Q-+K” approach improves statistical power compared
to “Q” only’. MLM can be described in Henderson’s matrix notation* as follows:

y=Xp+Zu+e

where y is the vector of observations; B is an unknown vector containing fixed effects, including genetic marker
and population structure (Q); u is an unknown vector of random additive genetic effects from multiple background
QTL for individuals/lines; X and Z are the known design matrices; and e is the unobserved vector of random
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residual. The u and e vectors are assumed to be normally distributed with null mean and variance of

ul G 0
Var[ malE

C
C
e 00 R

(2 L2

where G = %2 K with  as the additive genetic variance and K as the kinship matrix. Homogeneous variance is
;2 r 2

assumed for the residual effect which means R=I®¢, where ®¢ is the residual variance. The proportion of

genetic variance over the total variance is defined as heritability (h?).

When K is derived from pedigrees, the elements of K equal 2*Probability(IBD), where IBD means that two
alleles drawn at random are identical by descent. Generally, K calculated from markers is an IBS matrix. The
resulting multiplier is then not ¢,? but some unknown constant times ¢,2. Some methods for calculating K, such as
those implemented in SPaGEDI, actually use markers to develop an estimate of the IBD relationship matrix. For
those values of K, the resulting variance estimate can be considered an estimate of ¢,” as long as the assumptions
of the method used to derive K are not violated for the population being analyzed. One implication is that two
different K matrices may give very different estimates of ¢, and heritability yet produce the same model fit and test
of marker association.

TASSEL implements several methods to improve statistical power and reduce computing time. The Restricted

72 r 2
Maximum Likelihood (REML) estimates of ®: and °¢ are obtained through the Efficient Mixed-Model

Association (EMMA) algorithm?* which is much faster than the expectation and maximization (EM) algorithm?.

TASSEL also implements a method called compression which reduces the dimensionality of the kinship matrix to
reduce computational time and improve model fitting. When MLM is used without compression (compression =
1), each taxon belongs to its own group. At the other extreme, GLM can be interpreted as maximum compression

(compression = n) with all taxa in a single group. In that case, it is not possible to estimate the random effect
;2 r 2
independently of error and ©« is absorbed into ®e¢. Between these two extremes, taxa can be grouped using

cluster analysis based on kinship. When n individuals are compressed into s clusters (groups), the kinship among
individuals is replaced with the kinship among groups. At some grouping levels, dependent on the trait and
population being analyzed, this compressed MLM has improved statistical power compared to the regular MLM?*.
The optimum grouping with the best model fit for MLM without fitting genetic markers has the best statistical
power for an association test of markers*. TASSEL allows users to specify the compression level (average number
of individuals per group), or to have the program determine the optimum grouping.

Similar to GLM, MLM performs an association test for each combination of traits and markers. TASSEL provides
users several options: 1) to estimate genetic and residual variance for each combination; 2) to get these estimates
once for each trait without fitting genetic markers and then to use those estimates to test markers; 3) to use a prior
heritability estimate provided by the user. The second option, named P3D (population parameters previously
determined), has the same statistical power as the first option*. Using the P3D method or using a prior heritability
can be much faster than calculating heritability for each marker.
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Using MLM is very similar to using GLM. The difference is that in addition to choosing the joint data set (or
numerical data set), kinship data must also be highlighted before clicking the MLM button to show the MLM
option dialog. The option of “No Compression” is the regular MLM which is equivalent to “Custom level=1". For
data sets with large numbers of taxa, the optimal compression option may be considerably slower than no
compression or user supplied compression. This is because the algorithm solves the model once for each of a
series of compression levels in order to determine the optimal one.

All MLM analyses create two output tables, model statistics and model effects. If compression is used, the analysis
creates three tables.

|| MLM _statistics_for_Filtered_mdp_traits + Filtered_mdp_population_structure + mdp_genotype_chrl_157104-3706018 @
Trait Marker Locus Site df F p errordf markerf2 Genetic Var Residual Var  -2LnLikelihood
dpoll Mone o] [m] [m] 257 [m] 8.008 14,585 1,477.183|
dpall PZEODE59. 1 1 157104 1 0.001 0.979 250 o] 8.068 14,585 1,477,183
dpall PZAD1271.1 1 1947984 1 4,339 0.038 243 0.015 8.068 14,585 1,477,183
dpoll PZAD3513.2 1 2914066 1 0,132 0,716 255 1] 8.068 14,585 1,477,183 _
dpoll PZAD3513.1 1 2914171 1 2,829 0,094 256 0.01 8.068 14,585 1,477.183| "
dpoll PZAD3514.2 1 2915073 1 0.044 0.834] 243 1] 5.063 14.585 1,477.133
dpoll PZAD3514.1 1 2915242 1 0.738 0.375 241 0.003 3.008 14,585 1,477,183
dpoll FZAD0D258.3 1 2973508 1 0.732 0.393 240 0.003 8.008 14,585 1,477,183
dpall PZAD2962.13 |1 3205252 1 0.967 0.326 244 0.004 8.068 14,585 1,477,183
Anall p7anIaa? 14 1 27n57487 1 nna n a7 EED] n 7 NAR 14 &ag 1477 13l T
o 2
[ prnt | [ Export{csv) |[ Export(rab) |
L The

statistics table shows the results of the tests for each trait. The first line is for the model with no markers. Following
that is a single line for each marker tested. The columns labeled “df”, “F”, and “p” are the degrees of freedom, F,
and p-value from the F distribution for the test of the marker. The column “errordf” is the degrees of freedom used
for the denominator of the F-test. The column labeled “markerR2” is the R2 for the marker calculated based on a

formula for R2 for a generalized least squares GLS) model as shown here.

The columns “Genetic Var”, Residual Var”, and “-2LnLikelihood” list 62a, 62¢, and minus two times the
model likelihood, respectively. When the P3D option is used, all of the values are the same for a given trait
because they are only calculated once. A second table lists the estimated effects of each allele for each
marker similar to the output for GLM. The compression results table shown below shows the likelihood,
genetic variance, and error variance for each compression level tested during the optimization process.
The meaning of groups and compression is discussed above in the description of the compression method.
The compression level with the lowest value of -2L.nLk is used for testing markers.
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p .|

| £ MLM_compression_for_Filtered_mdp_traits + Filtered_mdp_population_structure + mdp_...&]
Trait # groups Compression -2LnLk Var_genetic Var_errar

dpoll 259 1 1,430,402 7.362] 8.1495| »
dpoll 243 1.044] 1,479.47 7.635 7.81
dpoll 243 1,068 1,479,505 7.656 7.855
dpoll 238 1.088 1,481.049 7.338 8.416
dpoll 234 1,107 1,482,935 6.957 9.068
dpoll 229 1.131 1,483.301 ©.904 9,201
dpoll 224 1.156 1,452.597 5.366 9.394
dpoll 220 1,177 1,486,718 6,172 10,578
dpoll 215 1,205 1,485.526 9.407 10,342
dpoll 211 1,227 1,486,045 6.21 10,703
dpoll 207 1.251 1,488,214 5.897] 11.345|

] 3

| Print || Export(csv) || Export(Tab) |

6.7 Genomic Selection (using Ridge Regression)

This function performs ridge regression to predict phenotypes from genotypes. It is one of the methods used for
genomic selection (GS).

The input dataset must contain one or more phenotypes and numeric marker data. Optionally, it may also contain
factors and covariates. The analysis is run by selecting the input dataset then clicking the “GS” button. Because no
additional user input is needed, the analysis will run immediately after the button is clicked. All traits will be
analyzed separately using all of the genotypes, factors, and covariates in the dataset. The output will consist of two
new datasets for each trait. One of the datasets will contain genomic estimated breeding values (GEBVs) for each
taxon and the other will contain BLUPs for each marker in the genotype file. The output datasets will appear in
the “Numerical” folder, which holds the input data as well. The output datasets can in turn be used for subsequent
analysis. For example, it could be joined with the input data so that the predicted values could be graphed against
the original values.

Understanding the input data requirements is important to ensure that the results of the analysis will be correct and
useful. Genotypes must be numeric with one column for each marker. It is expected that the markers are bi-allelic,
with the homozygotes coded as 1 and -1 and the heterozygotes coded as 0. However, any reasonable coding
scheme will work. For instance, missing data could be replaced by a probability resulting from imputation. If any
genotype data is missing, it will be imputed as the average of the marker scores across all taxa for that marker. If a
user prefers to use a different method of imputation, then the missing genotypes must be imputed before importing
the data into TASSEL.

GEBVs will be calculated for all taxa in the dataset, including any lines that have missing phenotype data. A
typical use of genomic selection is to predict GEBVs for a set of unphenotyped lines based on the performance of
a training set. To do that a dataset containing both the genotypes to be predicted and the genotypes of the training
set can be joined with a dataset containing the phenotypes of the training set using a union join. All taxa in the
phenotype set should have genotypes. If an individual without genotype data is included, all the marker data for
that individual will be imputed, which is not a generally useful thing to do.
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6.8 Geno Summary
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Cenotype Summary

G) Genotype Overview
(*) Site Summary
(*) Taxa Summary

| Ok | [ Close |

TASSEL (Trait Analysis by aSSociation, Evolution, and Linkage) 5.0.5

¥ [ Sequence

L

| mdp_genotype

[ Result
¥ [ ] Genotype Summary

L

mdp_genotype_OverallSummary
mdp_genotype_AlleleSummary
mdp_genotype_SiteSummary
mdp_genotype_TaxaSummary

L,
L
L,

File Data Filter Analysis Results Help

-

Table Title: Overall Summary
Number of columns: 2

Number of rows: 14

Number of elements: 28

Overall Summary of mdp_genotype

Stat Type
Number of Taxa
Number of Sites
Sites x Taxa
Number Not Missing
Proportion Mot Missing
Number Missing
Proportion Missing
Number Gametes
Gametes Mot Missing
Proportion Gametes Not Missing
Gametes Missing
Proportion Gametes Missing
Number Heterozygous
" Proportion Heterozygous

Value

281
3093
869133
837722
0.96386
31411
0.03614
1.7383E6
1.6754E6
0.96386
62822
0.03614
9622
0.01107

Number of Taxa - Number of Taxa in data set.

Number of Sites - Number of Sites in data set.

Sites x Taxa - Number of sites multiplied by number of taxa.
Number Not Missing - Number allele values not unknown (NN)
Proportion Not Missing - Number Not Missing / Sites x Taxa
Number Missing - Number unknown (NN) values
Proportion Missing - Number Missing / Sites x Taxa
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Number Gametes - Number of Sites x Number Taxa x 2
Gametes Not Missing - Number of gametes not unknown
Proportion Gametes Not Missing - Gametes Not Missing / Number Gametes
Gametes Missing - Number unknown (N) gametes
Proportion Gametes Missing - Gametes Missing / Number Gametes
Number Heterozygous - Number of heterozygous values
Proportion Heterozygous - Number Heterozygous / Sites x Taxa

| 8006 TASSEL (Trait Analysis by aSSociation, Evolution, and Linkage) 5.0.5

File Data Filter Analysis Results

¥ L Sequence

' mdp_genotype
[ Result
¥ ] Genotype Summary

_" mdp_genotype_OverallSummary
mdp_genotype_SiteSummary
mdp_genotype_TaxaSummary

L,
L
L,

r

Table Title: Allele Summary
Number of columns: 4

Number of rows: 27

Number of elements: 108

Allele Summary of mdp_genotype

Help
Alleles Number Proportion | Freguency
C 246327 0.28342 0.29404
G 235079 0.27048 0.28062
T 178046 0.20485 0.21254
A 168648 0.19404 0.20132
N 31411 0.03614 0.0375
Y 3938 0.00453 0.0047
R 2698 0.0031 0.00322
5 994 0.00114 0.00119
K 839 9.6533E-4 0.001
W 596 6.8574E-4 7.1145E-4
M 557 6.4087E-4 6.649E-4
cT 547 0.17685 NaN
G:A 486 0.15713 NaN
T:C 408 0.13191 NaMN
AG 373 0.12059 NaMN
G:C 219 0.07081 NaMN
CA 184 0.05949 NaMN
GT 165 0.05335 NaMN
CG 155 0.05011 NaMN
AT 121 0.03912 NaMN
T:A 110 0.03556 NaMN
TG 108 0.03492 NaMN
AC 78 0.02522 NaMN
cC 50 0.01617 NaN
GG 46 0.01487 NaN
ALA 24 0.00776 NaN
TT 19 0.00614 NaN

lass met.maizegenetics.util.SimpleTableReport

Alleles - Allele values present in data set. Single letter values are diploid where some letter represent
heterozygous. Two letter values are major / minor combinations with count of sites.

Number - Number of occurrences

Proportion - Percentage the value occurs in data set.

Frequency - Percentage the value occurs in data set not counting unknown (N) values.




| 8006 TASSEL (Trait Analysis by aSSociation, Evolution, and Linkage) 5.0.5

File Data Filter Analysis Results Help
[ Data Site Number | Site Name Chromoso... Physical Po...| Mumber of ... Major Allele | Major
0 PZBOORBS... 1 157104 281 C
v
ESE:QL.IEHCE 1 PZADLZ7... 1 1947984 281 G
| mdp_genotype Z PZAD36L... 1 2914066 281 T
[ Result 3 PZAD36L... 1 2914171 281 T
¥ ] Genotype Summary 4 PZAD3BL... 1 2915078 281 G
_' mdp_geno{vpe_meralmummaw 5 PZAD36I1... 1 2915242 281 T
" i o e crmos 1 ommwe
_: mdp_genotype_SiteSummary 8 PZADZ96... 1 3205262 281 C
_| mdp_genotype_Taxasummary 9 PZADDS9... 1 3206090 281 T
10 PZADZ12Z... 1 3706018 281 C
11 PZADOD39.. 1 4175293 281 T
12 PZADZ286... 1 4429897 281 C
- " 13 PZADZ2E6... 1 4429927 281 C
.. 14 PZADZ2EB6... 1 4430055 281 T
E}::ﬂ:ﬁf;ﬁi‘;’:_";i’v 15 PZA0203... 1 4490461 281 A
Number of rows: 30§3 16 zagll.5 1 4835434 281 A
Number of elements: 108255 i; ;:g:ig i :gg:g:g ggi 5
Site Summary of mdp_genotype 19 PZDOOOS... 1 4836542 281 C
20 zagll.1l 1 4912526 281 A
21 PZBOO91... 1 5353319 281 C
22 PZBOO91... 1 5353655 281 G
23 PHM2244... 1 5562502 281 G
24 PZAD309.. 1 8075572 281 G
- 25 PZADOLS... 1 8366368 281 G
26 PZADOLS... 1 38366411 281 T
lass net.maizegenetics.util.SimpleTableReport

Site Number - Index of site

Site Name - Name of site

Chromosome - Chromosome

Physical Position - Physical Position on Chromosome

Number of Taxa - Number of taxa for site (same of all)

Major Allele - The major allele of site

Major Allele Gametes - Number of times major allele occurs for site (up to twice number of taxa)
Major Allele Proportion - Major Allele Gametes / (Number of Taxa * 2). Number of Taxa * 2 is the
Number of Gametes for a Site.

Major Allele Frequency - Major Allele Gametes / (Number of Taxa * 2) - Gametes Missing)

Minor Allele - The minor allele of site

Minor Allele Gametes - Number of times minor allele occurs for site

Minor Allele Proportion - Minor Allele Gametes / (Number of Taxa * 2). Number of Taxa * 2 is the
Number of Gametes for a Site.

Minor Allele Frequency - Minor Allele Gametes / (Number of Taxa * 2) - Gametes Missing)
Gametes Missing - Number of gametes with unknown (N) value

Proportion Missing - Gametes Missing / (Number of Taxa * 2)

Number Heterozygous - Number of taxa that are heterozygous for site.

Proportion Heterozygous - Number Heterozygous / Number of Taxa (not counting taxa that are unknown
(NN))

Inbreeding Coefficient -



e Inbreeding Coefficient Scaled by Missing -

|80 0 TASSEL (Trait Analysis by aSSociation, Evolution, and Linkage) 5.0.5
File Data Filter Analysis Results Help

Taxa Taxa Name  MNumber of ... Gametes M... Proportion... | Mumber He... |

. 0 33-16 3093 190 0.03071 33

v ﬁSsiquence 1 38-11 3093 78 0.01261 22

| mdp_genotype 2 4226 3093 176 0.02845 27

[ Result 3 4722 3093 790  0.12771 147

¥ [ Genotype Summary 4 AlBB 3093 158 0.02554 25

_L mdp_gennwpe_meralmummaw 5 AZ14N 3093 118 0.01908 25

_L mdp_genmvpe_AIIeIeSummar\r b AZ239 3093 76 0.01229 il

“ md SiteSumma 7 A2T2 3093 330 0.05335 50

| mep_genatype_ i 8 A441-5 3093 80  0.01293 26

il mdp_genotype_TaxaSummary 9 AS554 3093 104 0.01681 34

10 AS56 3093 254 0.04106 25

11 Ab 3093 7B 0.01261 E1S]

12 ABL19 3093 124 0.02005 3B

— |13 AB32 3093 98 0.01584 32

n 14 AB34 3093 114 0.01843 33

Lit:.:eb;téef' ;ﬁﬁ;i';m;“aw 15 AB35 3093 150  0.02425 40

Number of rows: 281 16 Ab41l 3093 142 0.02296 26

Numbar of elaments: 2530 17 AbB54 3093 226 0.03653 3l

Taxa Summaw of mdp genotype 18 ABS9 3093 160 0.02586 il

- 19 AbB1 3093 408 0.07565 29

20 ABT9 3093 140 0.02263 29

21 ABBO 3093 128 0.02069 44

22 AbBZ 3093 112 0.01811 33

23 AB2BA 3093 238 0.03847 25

24 E10 3093 118 0.01908 ib

- 25 BE103 3093 136 0.02199 29

BE104 3093 112 0.01811 30

Taxa - Index of taxa.

Taxa Name - Name of taxa

Number of Sites - Number of sites for taxon (same for all).

Gametes Missing - Number of gametes with unknown (N) value. Every taxa / site combination has two

gametes.

Proportion Missing - Gametes Missing / (Number of Sites * 2)

e Number Heterozygous - Number of sites that are heterozygous for taxon

e Proportion Heterozygous - Number Heterozygous / Number of Sites (not counting sites that are unknown
(NN))

e Inbreeding Coefficient -

e Inbreeding Coefficient Scaled by Missing -

6.9 Stepwise
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7 Results Menu

Results consists of the functions to present data as table or graphics.

7.1 Table

Allows data to be displayed in a spreadsheet view and exported into a flat file.

To create a table, select a data set from the Data Tree panel, then click on the menu “Results -> Table”.

| 4 TASSEL (Trait Analysis by aSSociation, Evolution, and Linkage) 5.0.6 x'

File Data Filter Analysis lRﬁD“SI GBS Help
). Data B Table <
£} . Sequence
- & mdp_genotype W A’Ch"’mp“" Present data in table
J. Resilt = 0Pt
£ ). Genotype Summary .
(X ¥mdp_genotype T4 " LD Plot
Hl Chart
[#  qqPlot
Wi Manhattan Plot

Shown below is an example in which the Taxa Summary is displayed.

= — i T e—— = »
(2] Taxa Summary - - - - B e —— - o]
Taxa Taxa Mame Mumber of Sites  Gametes Missing Proportion Mis... Number Heter... Proportion He... Inbreeding Co... Inbreeding Co...

0|33-16 3093 190 0.031 33 10.011|Inbreeding Coe... ICSBM -
1)38-11 3093 78| 0.013] 22 10.007Inbreeding Coe... ICSBM T
2/4226 3093 176 0.028| 27| 10,009 Inbreeding Coe... ICSBM

34722 3093 790 0. 128 147 10.054/Inbreeding Coe... ICSEM =
4|A188 3093 158 0.026| 25 10,008 [Inbreeding Coe... ICSEM

5/A214M 3093 118} 0.019| 25 10.008 [Inbreeding Coe... ICSEM

6|A238 3093 76 0.012 31 0.01|Inbreeding Coe... ICSBM =
7|A272 3093 330 0.053 50 0.017|Inbreeding Coe... ICSBM

B8|A441-5 3093 80 0.013 26 0.005 |Inbreeding Coe... ICSBM

9|A554 3093 104 0.017| 34 0.011{Inbreeding Coe... ICSBM

10/A556 3093 254 0.041 25 0. ding Coe... 1CSBM

11A6 3093 % 0.013 36 0.012[Inbreeding Coe... ICSBM

12/A619 3093 124 0.02 33 0.013|Inbreeding Coe... ICSEM

13/A632 3093 98 0.016| 32 0.011]Inbreeding Coe... ICSEM

14/A634 3093 114 0.018 33 0.011{Inbreeding Coe... ICSBM

15/A635 3093 150 0.024) 40 0.013{Inbreeding Coe... ICSBM

16/A641 3093 142 0.023 26 0.005 Inbreeding Coe... ICSBM

17/A654 3093 22 0.037| 31 0.01[Inbreeding Coe... ICSBM

18/A659 3093 160 0.026 3 0.01[Inbreeding Coe... ICSEM

194861 3093 68| 0.076 F) 0.01[Inbreeding Coe... ICSBM
204578 3093 140 0.023 i) 0.01[Inbreeding Coe... ICSBM

21/A580 3093 128 0.021 + 0.015[Inbreeding Coe... ICSBM

22/A532 3093 112 0.018 33 0.011{Inbreeding Coe... ICSEM

23/AB28A 3093 238 0.038 25 0. ding Coe... ICSEM

2‘1“?10 3093 118 0.019) 36 0.012|Inbreeding Coe... ICSBM

25/B103 3093 136 0.022] 29 0.01|Inbreeding Coe... ICSBM

26B104 3093 112 0.018 30 0.01]Inbreeding Coe... ICSEM

27B105 3093 80 0,013 2 0,009 Inbreeding Coe... ICSEM

288109 3093 284 0,046 43 0.015[Inbreeding Coe... ICSBM

2B115 3093 114 0.018 26 0,008 Inbreeding Coe... ICSEM
30B14A 3093 68/ 0.011 36 0.012[Inbreeding Coe... ICSEM
31B164 3093 68/ 0.011 26 0,008 Inbreeding Coe... ICSEM
322 3093 54 0.009/ 34 0.011Inbreeding Coe... ICSEM
3337 3093 90| 0.015 26 0.009 Inbreeding Coe... ICSEM
4B 3093 244 0.039/ 30 0.01|Inbreeding Coe... ICSEM
3552 3093 122 0.02 18 10.006 [Inbreeding Coe... ICSBM
36B57 3093 116 0.019| 17} 10.006 Inbreeding Coe... ICSBM
3764 3093 156/ 0.025| 28 10.008 Inbreeding Coe... ICSBM
3863 3093 144 0.023] 33 10.011|Inbreeding Coe... ICSBM
39B73 3093 56/ 0.009| 23 10,008 Inbreeding Coe... ICSBM L

4 »

(e ] (CBwontcn ) (oo |

— —— — = — = ——
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Data can be sorted by clicking on the column header of interest. A secondary sort can be done by holding down
the CTRL key and clicking on a second column.

Data can be exported to flat files that are either comma-separated (Comma Separated Values = CSV) or
tab-delimited. Both these formats can then be imported into a spreadsheet program such as Excel. Tables can also
be printed.

7.2 Archaeopteryx Tree

Select a “Tree:...” data set to use. https://sites.google.com/site/cmzmasek/home/software/archaeopteryx

¥ [ Tree

Bl Tree:mdp_genotype
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e 00 Archaeopteryx 0.955 beta x (2010.01.15)
File Tools View as Text FontSize Options Type Analysis Help

|i‘1I Phylogram

|21 Dyna Hide

|21 Rollover

|21 Show Internal Data

|21 Taxonomy Colorize
Colorize Branches

Display Data:

IZT Node Name

|21 Taxonomy Code

|i‘1I Taxonomy Mame
Prot/Gene Symbal
Pret/Gene Name
Prot/Gene Acc
Confidence Valua

Event
Click on Nede to:

Display Node Data =

LEo

Order Subtrees

Uncollapse All

Search:

7.3 2D Plot

Displays 2D plots and determines color thresholds.

This function is useful for plotting associations in multiple environments.

First, select the desired result set. Using the drop down boxes provided, populate rows with “Environment,”
columns with “Site,” and value with “PermuteP.” The cutoff value for coloring can be chosen either by inputting a

value in the text box or by using the slider tool to the right of the text box. Users can “mouse over” any box to
view the value associated with that box, as shown here:
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T 2-D chart
@ @ g &y |Cel| size | 14 v [] enly upper triangle ||:| P-value @
Rowe: Environment.v' Colurmn: Site 'v' Value: | PermuteP .v.

Cutoff | 0,001 J Save ShG

PermuteP 18 511 6525 330 1000 1459 1490 1570 1613
CLAVTON.ID1S I
HOMESTEAD. 1D I
IStatistics -Min: 0.0 Max: 0,93 Mean: 0,2655733 50; 0,32200772 |HOMESTEAD.ID1:14QD(D.D}||

If P-value coloring is desired, simply check the P-value box as shown below:

T 2-D chart
@ E Ay &y |Cel| size | 14 v [ Jonly upper triangle ‘ Fifaing @
R Environment.v' Caolumn: Site .v. Value: |Permuter .v.

Cukaff Save SMG

PermuteP 15 511 625 50 1000 1459 1430 1570 1615
CLAYTON.ID1S I B
HOMESTEAD. D1 —— | |
Statistics - Min: 0.0 Max: 0,95 Mean: 02655755 SD: 0,32200772 [HOMESTEAD.ID1:1455(0.04) |

By checking the P-value box, Cutoff selection tools will be disabled and fields will instead be colored according
to the following grayscale:

-,

)
Dialog

B

Y o.oo1-0.01

0,01 -0.05

=0.05

I Ok l [ Cancel ]

This key can be shown by clicking on the “?”” icon next to the P-value check box.

7.4 LD Plot

Displays the results from a linkage disequilibrium analysis.
After selecting the desired result from the Data Tree, choose Results -~ LD Plot

The graph that is generated displays LD between pairs of sites calculated with the analysis step. The black
diagonal represents LD between each site and itself. The default setting graphs # in the upper right and p-values
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in the lower left. This default can be modified by clicking on the buttons in the lower left. The left side of the
graph contains a text description with the Chromosome and the Site name. At the bottom of the graph is a display
of the position of each site along the chromosome. This display can be hidden by deselecting the “Schematic”
check box. Legends that describe the color scheme appear on the right hand side of the graph.

The number of sites displayed can be selected by entering a number in the white box in the upper right corner or
by moving the sliding bar next to it. To move through the graph use the sliding bars on the right and bottom. The
red box in the small white window in the upper left corner will show what portion of the graph is displayed. To
move only around the diagonal select the “Lock Y Axis to X” check box (recommended when visualizing a LD

by sliding window analysis).

I . = - e —— "
|| Linkage Disequalibrium —— s g
Sedect visvable size

Upper triangle; | R Squared

Lewver triangle: | P-Vale
— =

LD plots can be saved in several formats. The Save button will save the area of the graph shown in the screen,
while the Save All button will save the entire graph.

7.5 Chart

Chart provides a variety of graphs for visualizing numeric data.
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This feature can be used to display histograms, XY plots, bar charts and/or pie charts. Any numeric table data can
be charted, including LD results, phenotypic data, diversity results, and association results.

Histograms: Use the graph type combo box to select the desired graph type (Histogram) from the list of options.
Up to two different series of data can be plotted together. Users may specify the number of bins to be used in the
histogram.

~

-\
& =Jo/ed
Graph Tvpe: Hiskograrm W [ Save ][ Properties ]
Series 1 |DF‘OLL.HOMESTEAD.ID1 [v]Series 2|DF‘OLL.CLM"TON.ID15 [V}Bins 35
DPOLL.HOMESTEAD.ID1 & DPOLL.CLAYTON.ID15 Distribution
12.5 1
10.0 1
7.5 1
5.0 1
l
2.5
0.0 T T T . II I
o 10 20 a0 40 50 G0 ¥a 20 oo 100 110 120
|M DPOLLHOMESTEAD.ID1 M DPOLL.CLAYTON.ID1S |

Scatter plots: Use the graph type combo box to select the desired graph type (XY Plot) from the list of options.
Select data to be plotted in X and Y axes using the appropriate drop down boxes. If two data series are plotted
simultaneously on the Y axis, the “2 'Y Axes” checkbox will provide an axis for each.
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DPOLL CLAYTOM.ID15

120 1

110

100

a0

80

70

G0

50 A

™ T

'i-l.
T Ll LL

-\
& BEX
Graph Tvpe: # Plak W [ Save ][ Properties ]
Y1 |DPOLL.CLAYTON.ID1S v| ¥2 |None [v]
% | DPOLL.HOMESTEAD.ID1 vl Mune V] Regression M2 fixes

DPOLL.HOMESTEAD.ID1 vs. DPOLL.CLAYTON.ID15

450 475 500 525 550 &S75 600 G25 650 G675 70O 725 750

DFOLLHOMESTEAD.ID1

B CPOLLCLAYTON.ID1S M DPOLL.GLAYTOM.ID1S Fitted Reg. Line

7.6 QQ Plot

7.7 Manhattan Plot

8 GBS Menu

http:// www.maizegenetics.net/tassel/docs/TasselPipelineGBS .pdf

9 Help Menu

Help provides information Tassel and diagnostics.

9.1 Help Manual

9.2 About

9.3 Show Memory

9.4 Logging
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10 Tutorial

This tutorial reviews several common scenarios for using TASSEL in order to help the user better understand its
capabilities for data manipulation and association analyses. The TASSEL software package includes a tutorial
data set that can be downloaded from the TASSEL website (please unzip all files to a directory of your choice).
This tutorial data set contains data for phenotype, genotype, population structure, and kinship.

10.1 Missing Phenotype Imputation

The phenotype file mdp_traits will be used to demonstrate the process of imputing missing data. Note that the
data set below contains missing values (NaN).

~

| | TASSEL (Trait Analysis by aSSociation, Evolution, and Linkage) 3.0.37 =NACIEL X

File Tools Help GDPC

EE‘E D... [ 0 Analysis ” @Results l ’Deletel [ Wizard l ’ [ show Memary l | 0% | h

[“ﬂ,,;:' GDP'CI ’El Load] [% Export] [T Sitesl ’D- Taxa] [T Trailsl ’&3 Impute SHPSI i7+5 Transform: ’PHQ Synonymizer] [.u Join]
T ® a8 ohr_&-290%

® _SEC.IUEHEE_ - * || Taxa EarHT dpall EarDia

- 4 Polymorphisms ) o5 o -

[=-- |, Mumerical i : 3 a o
[ 4 SBmmn suckre | il
Y Wrdp_traits e . : :

= || Matrix 4226 65.5 59.5 32.21933

. mdp_kinship - | 3722 31.13 71.5 32.421

— A138 27.5 62 31.419

Takle Title: Phenotypes & jA214n 65 69 32.0086

Number of columns: 4 ‘E| A233 47.83 61 38,0684

Number of rows: 301 | jaz72 35.63 70 Mal

Humber of elements: 1204 - :;:i_ﬁ ;;: 2;5 ;:2[;2?5 i

|-| A556 28 65 31929
Loard ] | | Cancel | | — ————— 5
[

To impute missing data, first select the mdp_traits data set in the Data Tree Panel and then click the Transform
button (Data [| Transform). The “Transform Column Data” window will open. Click on the Impute tab in this
window. Finally, click on the Create Data set button to create the new data set with missing values imputed.

Note that missing values are now filled.
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. _ .
| 4| TASSEL (Trait Analysis by aSSociation, Evolution, and Linkage) 3.0.37 B — = ] | S
File Tools Help GDPC

[ccmc [ 0 Analysis ” @ Results l ’Deleiel [ Wizard l ’ M show Memary l | 0% | h
[.m:' GDPCI l_l Load] [@ Exp-ort] [‘f Sitesl ’D- Taxa] [T Trailsl ’ﬁ" Impute SHPSI ’?+5 Translorml IPHG Synonymizer] [.u Jom]
da chr_g-2404
. F;Iymorspicll;r::ce r || Taxa EarHT dpoll EarDia
EI Mumerical 38-11 02,25 68.5 37.397 -
Co mdp_population_structure |E ﬁisz :iiS ;'31: giiiﬂ '
- 4 mdp_traits ' ' '
L g EEw———— A135 27.5 62 31.419
5} Matrix - | |az1an &5 &9 32.006
- = A238 47.88 61 36.064
Imputed FPhenotypic Values. “ | |Ad41-5 53.5 67.5 35.008
Taxa with insufficient data: 35 A554 38.5 G5 33.41775
- = |AS56 28 65 31,929
¥ = 30.8% cutoff): El
) — | JAB 109.5 80.5 31.5175 i
AG19 36 &1 40.63
|A| A632 &0 61 35.953 i

10.2 Principal Component Analysis

Principal component analysis (PCA) is a statistical tool that transforms a set of correlated variables into a smaller
number of uncorrelated variables called principal components (PCs). The first PC captures as much of the
variation as possible, and the succeeding PCs account for a decreasing fraction of the remaining variance. Another
application of PCA is to use PCs derived from genetic markers to represent population structure®. This method
requires much less computing time than maximum likelihood estimation. As most marker data are characters,
numericalization must be performed first. A common approach for converting character marker scores is to set one
of the homozygotes to 0, the other homozygote to 2, and the heterozygote to 1. For haploids, the conversion can
be simply performed by coding one allele as 0 and the other as 1. The TRANSFORM function in TASSEL
converts the major allele to 0. All the other alleles are collapsed to a single class and coded as 1. PCA requires that
all variables should have variation and should not have missing values. As a result, filtering genotype to eliminate
monomorphic markers and imputing missing values may be necessary. Imputing missing values can be done
before or after numericalization. Here we demonstrate how to generate PCs from the genotype file in the tutorial
data.

. Remove monomorphic sites: Make sure TASSEL is in Data mode. Highlight the genotype and click Site. Set the
minimum frequency to 0.05 and have “Remove minor SNP status” checked. Click Filter.

. Numericalization: Highlight the filtered genotype and click Transform. Use the default option of “Collapse non
major alleles.” Click Create data set.

. Imputation of missing values: Highlight the numerical genotype and click Transform and then click Impute Tab.
Use the default options. Click Create data set.

. PCA: Highlight the imputed numerical genotype, click Transform, and then click PCA Tab. Change the default
option to “Components=3" by choosing Components and type 3 in the text box. Click Create data set.
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B Filter Alignment gl i

Filter Alignment .;'E';,.
Minimum Count: 210 out of 281 sequences
Minimum Frequency: 0.05
Position Type: Pasition index Physical Pasition (AGP) NUI’I’IEFIEE' GEI-ID-I--!'.I:'E H
Start Position: |EI |157m4 ‘
End Pasition: |2560 148907116
of 2561 stes

‘@ Collapse Non Major Alleles

[ Extract Indels

Rlemove minor SHP states

A (") Separate Alleles

Il

Create Dataset Close

SSEL (Trait Analysis by aSSociation, Evolution, and
File Tools Help &DPC

[_EEEData ” ¢Analysis ]@Results ] [Delete] [ Wizard ] [ M shaw Memary ] @

’m GDPC] [?1 Luad] [@ E:port] [Y Sites] [b- Taua] [Y Traits] ’ﬁﬂ Impute SNPSI [?»5 Transfurm] [p«»q Synonymizer] [. u Juin] I(I) n Jnin] [OO Separate]

EData ~ ) ) ) ) }
T — Phyysical Positions Site Mumbers Locus Alleles | Erter physical position |
I-63 sequence (® Fhy O O O {Enter physical p )
----- # mdp_genotype
# mdp_genotype 1 | 1 [ ’
157104 24945772 49740440 74532108 99323776 124115444 148907112
M~ = I~ W 07 — (7 @ 0 W = O 00 W0 0 = O 7 6 O 0 o O 0 — O — O O = = O
oM om0 M~ 0 m Mo s — D D W W e— - 0= 000 R 07 = - P 00 D o= 7
eSSz 2aidzededssidllaesalsananezza
0o 00 = — — W0 WD~ Mmoot m D O 0O M~ [~ O Wm0 NN O O O W
Frop = A < e T TR = = R i < ===
# mdp_population_structure R R T e e A e A = -~ = -~ o T O Bl -
® mdp trats G [ ) il it il il i i i Bl [t i b it ! ) ) ) B ] e el sl () ) s ) e e
(-5 Matrix e el R R =TT = =i R = e ===
33-16 Tlr|alc|t|alc|n|a|a|c|c|als|a|c|t|c|a|c|clalalc|c|a|a|n|alalalala
 Synonymizer 38-11 G|[T|G|C|T |G| N|G|G|G|C|T |A|A|G|C|T|C|A|C|T C|C|C|C|a|G|A|G|G|G|aA]—
Result 4226 T(T[a|[N[T|A|C|G|G|C|C|T|A|A|G|C|T|C|G|A|C C|C|T|C|A|G|A|G|G|C|A
Ad 4722 T[T |[a|c|T|N|C|a|G|C|T|C|A|G|G|N|T|C|G|C|C|C|G|M|N|N|G W N A G A
< | & £186 T|(T|G|C|C|N|C|G|G|G|C|T |G|A|G|C|T|C|G|C|T A|G|C|C|a|G|A|A|A| G| A
Mumber of sequences: 281 ) AZ14N T(T[a|C|[T|A|C|G|G|G|C|T|A|A|G|C|C|C|G|C|C C|C|T|C|N|[G|W|G|G|G|A
u ‘o 25'61 = 4230 T(T|G|c|T|G|C|a|G|C|T|T|A|G|a|T|T|C|A|C|T C|C|c|C|a|G|A|G|G|C|A
wdber of sites: ) Az7z T[T|G|c|c|G C|A|G|C|T|[C|A|G|G[T|[T|C|G|C|[C C|C|N|[C|[A|A|[N|A|A|[G|HN
Data type: IUPACNucleotide r A441-5 T|T|a|C|C|N|C|G|G|C|C|T|A|G|G|C|C|C|A|C|C|C|C|T|C|G|G|A|G|G|G]|A
- AES4 T(T|G|C|T|G|C|a&|G|C|T|T |A|G|G|C|T|C|G|A|C &|C|T|C|G|G|A|G|G|C|A
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Three items will be added to the data tree after running PCA. The first are the PCs. The second are the
eigenvalues. And, the last are the eigenvectors. Here we use the Chart Function in the Result mode to graph the
first three PCs, the individual eigenvalue contributions (sometimes called a skree plot) and the cumulative
eigenvalue contributions. The eigenvalues are of interest because they equal the variance explained by each of the

PCs.
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10.3 Estimation of Kinship using genetic markers

While PCs can be used to capture major population subdivisions, kinship can be used to capture more subtle
relationships. This section shows how to create a kinship matrix based on the same SNP data used to calculate
PC’s.

. Remove monomorphic sites: Highlight the genotype and choose Filter/Sites on the menu bar. Set the threshold
on MAF to 0.05, check “Remove minor SNP status,” then click Filter.

. Estimate kinship: Highlight the filtered genotype and click Analysis/Kinship. Leave “Scaled IBS” selected in the
“Choose Kinship Method” dialog and click OK. A kinship matrix will be added to the data tree under Matrix
category.

. Alternatively, impute missing genotype data first then create the kinship matrix using the imputed data. To impute
missing data, highlight the filtered genotype, choose Data/Transform, leave “Collapse Non-Major Alleles”
selected, and click “Create Dataset”. A new data set with “ Collapse” appended will appear in the “Numerical”
folder. Highlight the collapsed data set, choose Data/Transform, select the Impute tab, then click “Create Dataset”.
Highlight the resulting imputed data then choose Analysis/Kinship.
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10.4 Association analysis using GLM

We use three files from the tutorial data set to perform association analysis using the GLM. The first file
mdp genotype.hmp.txt, a set of SNPs scored at 3093 sites on 281 maize inbred lines. The second one is the
population structure of 282 maize inbred lines (mdp population_structure.txt). The last one is phenotypes for three
traits, for 282 maize inbred lines (mdp _traits.txt). The statistical model is:

Flowering time = Population structure + Marker effect + residual

Remove monomorphic and low coverage sites: Highlight the mdp genotype and click Filter/Sites on the menu
bar. Set “Minimum Frequency” to 0.05, “Maximum Frequency’’to 1.0, and “Minimum Count” to 150. Click
Filter to create a filtered genotype data set.

Trait selection: Highlight the phenotype and click the menu item Filter/Traits. Uncheck all the traits except
flowering time (DPOLL). Make sure that the Type is set to Data. Click OK to create a filtered phenotype.

Covariate selection: The population structure is presented as the proportion of each population. There are three
populations represented as Q1, Q2, and Q3. They sum to 100%. This creates linear dependency if we use all of
them as covariates. While GLM can handle that properly, it will cause MLM to complain and refuse to complete
your analysis. We can eliminate the dependency by removing one of the Q variables. In this demonstration, we
exclude the last one. Highlight mdp population_structure and click Filter/Traits. Uncheck the last population
(Q3). Make sure that the Type is set to Covariate. Then click OK to create a filtered population structure data.

Joining data: Highlight the three filtered data sets by holding the Control key while selecting the individual data
sets. Then click the menu item Data/Intersect Join to create a combined data set.

Association analysis: Highlight the joint data set then click the menu item Analysis/GLM to perform association
analysis. Two reports will be added to the data tree.
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One of the reports added to data tree is labeled “GLM_Marker Test ™ followed by the name of the joint data. In
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addition to the information for traits and markers, the data set contains the following statistics:

marker F:F value from the F test on marker;
marker p: P value from the F test on marker;
markerR2: R? for the marker after fitting other model terms (population structure);

markerDF: Degree freedom of marker;
markerMS: Mean square of marker;

errorDF: Degree freedom of residual error;

errorMS: Mean square of residual error;
modelDF: Degree freedom of model;
modelMS: Mean square of model.
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Clicking “marker p” will sort the table by P value. The smallest P value is 3.5963x10°. A reasonable
significance threshold is 1.9x107, which is 5% after Bonferroni multiple test correction (0.05/2559). The
denominator in the Bonferroni correction is the total number of SNPs tested. The association was significant.

The other data added to the data tree is labeled “GLM_Allele Estimates  followed by the name of the joint data.
For the most significant SNP (highlighted in the figure below), there were two genotypes (AA and GG). There
are 220 lines with genotype AA and 41 lines with allele GG. For the trait dpoll (days to pollination), the difference
between the two homozygotes was 3.86 days.
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10.5 Association analysis using MLM

Running MLM in tassel is similar to running GLM. The difference is that in addition to the joint data (or
numerical data), MLM requires kinship data to define the relationship between individuals. The kinship matrix
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times a parameter equals the covariance matrix between individuals. Here we use kinship file from the tutorial data
set to fit the following statistical model.

Flowering time = Population structure + Marker effect + Individuals + residual
Individuals and the residual are fit as random effects. The other terms are treated as fixed effects.

With respect to the marker effect, we will demonstrate the analysis using two sets of markers. One is the dwarf8
gene sequence used in the GLM tutorial. The other is a set of 3093 SNPs spread across the maize genome.

For the dwarf8 gene sequence, use the joint data set created by following the tutorial for GLM. Solve the mixed
linear model by highlighting the joint data set and the kinship data then clicking the MLM button in Analysis
mode.
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An MLM option dialog will pop up as shown above. Choose the default options, which use P3D and
compression at the optimum compression level. After the Run button is clicked, the progress bar will start moving.
The time required will depend on sample size, number of traits, number of markers, and the options chosen in the
MLM option dialog. After the progress bar is reset to zero, indicating completion of MLM, three reports will be
added to the data tree. The first two are similar to the reports created by GLM. The most significant SNP is still the
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same, however the strength of association is weaker, with a P value of 7.199x10™ (vs. 1.1021x10* from GLM)
which does not pass the Bonferroni multiple test threshold (5x107%).

The third report contains the MLM specific statistics, including -2 Log Likelihood, genetic variance and residual
variance components under different level of compression. These statistics are illustrated by the Chart function on
the Result mode as follows.
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In the example, 79 are included in the final analysis. When they are clustered into 44 groups, the -2 Log
Likelihood reaches a minimum, which indicates the best model fit. The screening of SNPs was performed at this
optimum compression level.

Note: When two or more individuals are clustered into one group, the variance component for the random effect is
not equivalent to the one without compression. Consequently, the heritability derived should not be interpreted as
the individual based heritability.

To perform a Genome-Wide Association Study (GWAS) on the 3093 SNPs, we need to create a new joint data
set containing the filtered phenotype, population structure, and the genome—wide genotype. Highlight the new
joint file and the kinship data and click the MLM button. Choose the default options on the MLM option dialog.
The analysis will take a minute or two. The output report labeled “MLM_compression” indicates that 259 lines
were used in the analysis. With 74 groups, the statistics from the best are as graphed below.
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The strongest associated SNP is at 193565357 bp on chromosome 3. The P value is 1.3027x10*. The threshold is
3.2331x107 at significant level of 1% after Bonferroni multiple test correction (0.01/3093). The association was
not significant. As illustrated below, the output labeled “GLM_Allele Estimates” shows the marker effects
assigned to genotypes for each SNP (The GLM is also the same). For example, the first SNP at 157104 bp on
chromosome 1 had three genotypes (AA, CC and AC) coded as A, C, and M based on the [IUPAC code, see
Appendix (Nucleotide Codes).
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- ® MM _compression_for Fitere | [ o) PZAD3613.1 |1 2914171 A 5. 46891 61 i
" ® MLM_statistics_for_Fitered_n =/ [ ) PZAD3613.1 |1 2914171 w 0 2 I
+® MLM_compression_for_Fitere | 1) PZAD3614.2 |1 2915073 G 1.27026-1 125
- ® MLM_statistics_for_Filtered_nl 1| [3 -0 PZAD3E14.2 |1 2015078 A o 118 |
g -_cfects_for_Filtered_m gyl mem] PZAD3614.1 |1 2015242 [T 0.55195 130
- ML comoression for Fitere = oo PZADI6141 |1 215242 A 0 111
dpal PZAD0258.3 |1 2973508 G 2785660 65
Table Title: MLM effects | [dpol PZAD0258.3 |1 2973508 c 3.3585E0 175
= -
Number of columns: 7 dpal PZAD0258.3 |1 2973508 s 0 2
- . , o | |dpol PZA02982.13 |1 sa0s252 [T 2,1007E0 218
< Lm ] r dpal PZADZ962.13 |1 5205252 A 3.2237E0 26
— |dpoll PZADZ962.13 |1 5205252 W 0 3
Load =" [dnal PZADZ382.1% |1 sas:62 | |C -2.0366E-1 224
dpal PZADZ962.14 |1 55262 |G 0 15
Export dpal PZAD0S99.25 |1 5206090 C 0.61187 E |
dpal PZAD0S99.25 |1 sae0s0 [T 128771 231
Transform | o dpoll PZAD0599.25 |1 3206090 \f 0 1
| |apat PZAD2125.1 |1 s7e018 [T 0.59304 124
ol ] | r dpall PZAD2129.1 |1 3706018 c o 131 -
Frogram Status J
L Il S T o B e
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11 Appendix

11.1Nucleotide Codes (Derived from IUPAC)

Code

Meaning

>

A:A

C:C

G:G

T:T

A:G

C:T

C:G

AT

G:T

A:C

+:+ (insertion homozygous)

c|l+[Z2|R|IE|lw|=|m|=|Q]|O

+:-

-:- (deletion homozygous)

Unknown

11.2TASSEL Tutorial Data sets

http://www.maizegenetics.net/tassel/docs/TASSEL TutorialData3.zip

File name Type Format

d8 sequence.phy Genotype Phylip Alignment
mdp_genotype.hmp.txt Genotype Hapmap Alignment
mdp_genotype.plk.ped Genotype Plink Alignment
mdp_genotype.plk.map

mdp_kinship.txt Kinship Numerical square matrix

mdp_population_structure.txt

Population structure

Numerical trait data

mdp_traits.txt

Phenotype

Numerical trait data
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File #1 is the sequence of dwarf8 gene with 2466 sites on 91 maize inbred lines. The data was described by the
paper on the association between Dwarf8 and flowering time?®.

File #2-6 are 3093 SNPs on 281 maize association inbred lines. The data was presented in three formats (Hapmap,
Plink and Flapjack). The data was created by the PANZEA project funded by NSF. Details of the data can be
found at http://www.panzea.org.

File #5 and 6 are in pair for the format of Plink.
File #7 is kinship created by Yu et al.’.
File #8 is population structure of 282 maize inbred line*’.

File #9 is phenotype on three traits, including flowering time, on 282 maize inbred lines’.
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11.3Frequently Asked Questions

1. Whatdo I do if TASSEL misbehaves?
TASSEL is an open source software project hosted on SourceForge and has a bug tracking list at
http://sf.net/projects/tassel where you can notify the developer community of problems. In order for a bug to be
fixed, we must be able to replicate the problem. Thus, it is important to document the steps that were taken that
produced the error. If the data you are working with is not too sensitive, please include the files which were
used in the faulty procedure. If you would rather not post your data file on SourceForge, you may email it to
one of the software developers.

2. Where do I turn for more information?
If you are having difficulty with a certain aspect of TASSEL, you can either email one of the software
developers listed at www.maizegenetics.net or you may check the TASSEL forum on SourceForge
http://sf.net/projects/tassel), as another user may have already addressed a similar question. There is also a
TASSEL discussion group at http:/groups.google.com/group/tassel.

3. How do I join the fun: TASSEL on SourceForge?

TASSEL is an open source project distributed under the GNU general public license. This means that the
source code is available and the user is free to modify the code to suit their particular needs. We welcome input
from developers and those who wish to become involved in the improvement of this software. The project is
hosted on SourceForge (http:/sf.net/projects/tassel), thereby allowing anyone to access the most recent changes
to the code. This setup makes it convenient for anyone to add special functionality to TASSEL if they so
desire. It also serves as a good platform for anyone who wishes to become involved in a bioinformatics
software development project.

4. When I click on the most current version of TASSEL web start, a previous version appears. What
should I do?
The previous version of TASSEL web start was cached in your machine. To replace it with the most current
version, click the Start button in Windows, followed by Run. Type javaws and then click OK. In the window
that opens, keep the most current version of TASSEL and delete the rest.

5. What should I substitute for missing values in TASSEL?
For numerical data in version 3 format, use NA or NaN. For numerical data in version 2 format, use “-999” for
missing values. For SNP data, use “N”. Kinship does not allow missing values.

6. Isit possible to change data names in the Data Tree?
Yes. Click on the desired data name in the Data Tree, wait for one second, and then click it again or
immediately hit the F2 key. Rename the data set and then hit Enter to save the change.

7. How can I create a TASSEL icon on desktop?
Click “Start” on Microsoft Windows and select “Control Panel”, then double click Java to show “java Control
Panel”. In “Temporary Internet Files” section, click “View” button show “Java Cache Viewer”. Move mouse
over TASSEL application and click right button and select “Install Shortcuts”.

g

Why do I get empty squares in MLM association analysis?
The empty square means null information. The major reasons include non-convergence in the estimation of
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9.

variance components or that the statistic in question was not calculated. For example, marker F, p, and R? are
not calculated when no marker is included in the model.

Why should I exclude one column of the population structure?
For some methods of calculating population structure, such as the software STRUCTURE, the population
proportions sum to one. This produces linear dependence between the population co-variates. While the
algorithm used by GLM tolerates that dependency, MLM will fail because the design matrix will not be
invertible Excluding one column eliminates linear dependence between columns. Using PC axes to represent
population structure does not result in linear dependency because all PC columns are guaranteed to be
independent.

10. Can kinship replace population structure?

11.

12.

13.

14.

15.

16.

Sometimes. For some traits and populations, the K-only model may be as good as or better than the Q+K
model. For others, Q+K may be superior. The Q-only model is not as effective for controlling population
structure as the alternatives. Unfortunately, no general guidelines exist for predicting which model will perform
best. As a result, an investigator may wish to fit all three models and compare the results. If eliminating false
positives is very important, then it may make sense to accept the most conservative model. However, if the
objective is to identify candidates for further study and the cost of following up on a false lead is low, the most
liberal model may be preferred.

Why do TASSEL and SPAGeDi give different kinship estimates?
First, many algorithms exist to calculate kinship and their estimates will differ from one another. Secondly, the
algorithm in TASSEL treats each genotype as a haplotype. It is not recommended that TASSEL be used to
generate a kinship matrix from heterozygous genotype. In the near future, the TASSEL kinship algorithm will
be modified to handle heterozygous diploids.

Can I get Marker R square using SAS Proc Mixed or TASSEL MLM?
SAS Proc Mixed does not produce an R? statistic. MLM in TASSEL does. The user manual describes how it
is calculated.

Does MLM find more associations than GLM?
Sometimes. MLM has higher statistical power than GLM and may detect more true associations.. When the
tested genetic markers are confounded with kinship structure , GLM does not correct for that as effectively as
MLM and may produce more false positives

Do I need multiple test correction for the p value from Tassel?
Yes.

Can TASSEL handle diploid genotype data?
While TASSEL accepts most common sequence alignment formats which handle polyploid genotype data
including haploid and diploid, some analyses are not appropriate for heterozygous data. GLM or MLM fit
SNPs one at a time, treating each distinct genotype as a separate class. This has the effect of fitting an additive
plus dominance model. Separating the two effects is under consideration. Because handling heterozygotes as a
third marker class is not appropriate for kinship or LD those analyses should not be used for that type of data
at the present time. Work to improve handling heterozygotes is ongoing.

How to cite TASSEL?
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The paper that describes TASSEL' as a software package and the papers that introduce specific methods

implemented in TASSEL should be cited as appropriate, such as the unified (“Q+K”) approach, EMMA,

compression of mixed linear model and P3D. For example,:

A. Linkage disequilibrium (D’, R? and P value) were calculated by TASSEL'.

B. Association analyses were performed with the mixed linear model approach® implemented by TASSEL'.

C. GWAS was performed with the compressed mixed linear model approach*? carried by TASSEL' which
also implemented the EMMA?® and P3D* algorithms to reduce computing time.
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